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1 Introduction 
 
Welcome to Leopard, the Spitzer Science Center Data Archive interface. The Leopard 
software is available to download from the Proposal Kit page at the Spitzer Science 
Center web site (http://ssc.spitzer.caltech.edu/propkit/spot/).   You will need to use 
Leopard to access both public, non-proprietary data products and data products resulting 
from your approved observing program. 
 
Leopard is a JAVA-based client-server software package based on the same architecture 
as Spot, the Spitzer Planning Observations Tool. If you are comfortable using Spot, you 
are already familiar with many features of Leopard. This User’s Guide provides 
information about the various features within Leopard. You can use Leopard to query 
specific observations from the Spitzer Archive, select various data products desired, and 
choose from direct data delivery to local disk or staged FTP for data delivery. 
  
The Release Notes that are packaged with the software provide additional information 
about computer platforms supported for this version, performance issues, and a list of 
known bugs.  A list of bugs/issues is updated regularly on the Proposal Kit web page 
(http://ssc.spitzer.caltech.edu/propkit/spot/).  
 
To make using Leopard easier, we recommend that you: 
1. Read the Release Notes that are packaged with the software (or download them from 

the web page).  Some, but not all, of that information is repeated here. 
2. Check the known bugs/issues list on the web page. 
 
You can find the resources you need to help you analyze Spitzer data at the Data 
Archives and Analysis webpage (http://ssc.spitzer.caltech.edu/archanaly/) on the main 
SSC website.  These resources include the data handbooks for the three Spitzer 
instruments (IRS, IRAC, MIPS), the data release status page, and links to the advance 
data products software and documentation, aka the post-BCD software. 
 
Please email us at the Spitzer Science Center (SSC) Helpdesk (help@spitzer.caltech.edu) 
with any questions or comments. 
 

2 This Release of Leopard 
 
This is the ninth release of the Leopard software. Future releases will incorporate more 
features as they are implemented. This release contains features, such as searching the 
Spitzer Archive with basic search parameters, selecting various data product types for 
retrieval, and two data download options – direct data delivery (preferred) or staged FTP. 
 
You may notice that Leopard looks a lot like Spot, the Spitzer Planning Observations 
Tool. Leopard is based on the same JAVA architecture as Spot and shares many of the 
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same features. If you are comfortable with using Spot, you are already familiar with 
many of the features of Leopard. 
 
Several items have changed in this version of Leopard.  In addition, we have added a 
number of new features.  We have attempted to encapsulate in the list below the most 
obvious changes that affect users the most: 
 
• Background calculation output format modified. 
• Inclusion of all Legacy Science enhanced data products in the Popular Products 

query. 
• Inclusion of “Select All” button in Query by Campaign/Observer. 
• Inclusion of IRS Staring and Spectral Mapping quicklook previews. 
• Depth-of-Coverage overlay now uses observation date, when available. 
• Catalog data available for image overlays from the VizieR service (in beta). 
• Visualization: Load FITS images from a URL. 
• Visualization: Load images from NVO Simple Image Access Protocol (SIAP) sites. 
• Visualization: Slice Tool now handles image overlay layers. 
• Visualization: Allow for creation of blank image for overlays. 
• Visualization: Removed 10° limit on Depth-of-Coverage overlays for MIPS Scan 

AORs. 
• Visualization: Allow for Depth-of-Coverage overlays for IRAC Post-Cryo Mapping 

AORs. 
• Various other improvements and bug fixes. 
 
There are two issues to note for this release of Leopard: 

1. If a data download fails, check your hard disk space. Leopard cannot tell if you 
have filled up your disk space, so an incomplete data download may be due to a 
full disk on your computer. 

2. Read the README files that come with the data download. They will indicate if 
the download was successful or if there were problems. 

 

3 Minimum Recommended Hardware Configurations 
 
Leopard is written in the JAVA language and therefore requires lots of memory and a fast 
processor in your computer.  If you run it on a system with less memory or processor 
power than our minimum recommended configuration, the software may work but it is 
likely to be slow and you will probably see window redraw/refresh problems. While we 
suggest minimum hardware configurations, we recommend that users have more RAM 
(512 MB or above) and a fast processor if you plan on intensive use of the visualization 
features within Leopard.  The minimum recommended hardware configurations are: 

3.1 Sun Workstations: Sun Ultra 5 with 256 MB RAM  
If you are not using the visualization features in Leopard then it may run acceptably on an 
Ultra 1 with 256 MB of RAM.  
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3.2 Windows PC (2000, NT, XP): 512 MB RAM 

3.3 Windows PC (Vista): 1 GB RAM 

3.4 Linux PC:  256 MB RAM  
We have done limited testing on Linux systems running with a Pentium 2 processor at 
266 MHz and 256 MB of RAM, as well as with a Pentium 3 processor and 256 MB of 
RAM. 

3.5 Mac: OS 10.4, 512 MB RAM; OS 10.5, 1 GB RAM 
We have tested Leopard on a G4 processor with 512 MB RAM under OS 10.4, and it 
runs acceptably.  However, we recommend 1 GB RAM for OS 10.5 (Leopard). 
 

4 Operating System Configurations Supported 
 
Please read the Release Notes (packaged with the software or available on the web page) 
for more details on operating system issues, particularly with respect to window 
managers. The majority of the testing for this version of Leopard has been done under 
Solaris 2.8, Windows XP, Linux, and Mac OSX. We do not anticipate major problems 
with other flavors of Windows. Except for Mac, the versions of Leopard in this release 
come with JAVA 1.5. 

4.1 UNIX:  Solaris 2.8+ 
The software has been tested on Solaris 2.8 and 2.10. 

4.2 Windows:  NT, 2000, XP, Vista 
The functionality of the software has been tested using Windows XP. Minimal testing has 
been completed using other versions of Windows, but we do not anticipate problems.  
Due to security measures for Windows Vista, you will need system administration 
privileges for software installation.  To allow auto-update under Windows Vista, use the 
right mouse button when clicking on the Leopard icon, and select “Run as 
Administrator.”  You can click on the icon and run Leopard normally thereafter. 

4.3 Linux:  RedHat 8.0, 9.0; Fedora Core; Enterprise 
Leopard on Linux runs acceptably on RedHat 8.0, 9.0.  We tested distributions ‘straight 
out of the box.’  We ran the GNOME windowing environment. We know that Leopard 
does NOT run properly with the fvwm2 window manager (all JAVA Swing programs 
seemed to hang) or KDE. Leopard also appears to run well under Fedora Core, although 
we have not yet fully tested Fedora Core 4 or 5.  Undoubtedly, there will be various 
Linux OS under which Leopard will not run successfully.  For example, we are not 
supporting Spitzer Pride for 64-bit Linux machines.  You will need to install the ‘generic’ 
package and download your own Java; see the Installation webpage.   
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4.4 Mac: OS X 
Leopard requires JAVA 1.5, so Mac OS 10.4 or 10.5 is required.  (Note:  Leopard will 
no longer run under Mac OS 10.3.) Apple offers JAVA 1.5 (JAVA 2 Standard Edition 
[J2SE] 5.0) as a software update.  By now, nearly all Mac OS 10.4 or 10.5 systems 
should be running JAVA 1.5, unless you have not allowed software updates to run over a 
year or so. You may need system administration privileges for software installation. 
 

5 Installing and Starting Leopard – Part of Spitzer Pride 
 
With this release we continue the tradition of the Spitzer Pride – Spot V18 and Leopard 
V9. Spot and Leopard share many of the same JAVA files and so are packaged together 
as Spitzer Pride. Spot/Leopard should be installed on the computer where you want to run 
them. The start-up script is not configured to allow it to run on an X-terminal. You can 
run them across a Sparc network if it is installed on a disk that is nfs mounted across the 
network. We run Spot and Leopard in this fashion at the SSC. The first step is to 
download the software from the SSC Proposal Kit web page onto your hard disk 
(http://ssc.spitzer.caltech.edu/propkit/spot/).  

5.1 Windows Installation 
After downloading the software, double-click on the Spitzer-pride18-windows.exe file to 
install.  After installation, click on the Leopard icon to start Leopard.  

5.2 Solaris or Linux Installation 
1. Go to the directory where you installed the Spitzer-pride18-solaris.sh or 

Spitzer-pride18-linux.sh file. You must have write permission in this directory 
and should have at least 200 MB of free disk space. 

2. At the UNIX/Linux prompt, type chmod +x Spitzer-pride18-solaris.sh (or 
Spitzer-pride18-linux.sh) to make the file executable. 

3. Type ./Spitzer-pride18-solaris.sh (or Spitzer-pride18-linux.sh) to run the 
installation script. 

4. When the script asks you for the directory name where you want to install 
Spitzer-pride, be sure to type the full directory path, e.g., /scr/user/my_pride. 
Make sure the directories exist before you try to install it there. If you are in the 
directory /scr/user/ and just type my_pride, it will tell you that the directory 
name must start with a slash. 

5. If desired, add this directory to your $PATH:  setenv PATH ($path 
/scr/user/my_pride) 

6. Type the name of the program (spot or leopard) to launch it. 

5.3 Mac Installation 
Click on the link for the software package, offered as a disk image (.dmg) file.  Drag the 
Spitzer-pride folder icon from the pop-up window onto your local disk into whichever 
directory you want to install the software.  For instance, you may wish this to be the 
Applications folder.  Double-click on the program to install it.  Click on the Leopard 
executable (.app file) to start Leopard.  NOTE:  Please be sure that Subscriber 
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application file (subscriber.app) is in the same directory as the Leopard application; 
otherwise, you will not be able to start up Subscriber and download data. 

5.4 Leopard Automatic Update 
The automatic update feature from the Options menu will allow the client side of Leopard 
to update itself if it detects that a newer version is available at the SSC. Leopard will 
access the updated files at the SSC via the Internet and will automatically install them on 
your computer.   Auto-update is the default setting when you first install Spitzer Pride.  If 
you turn this feature off, or decline an auto-update at any time, Leopard will remember 
that you have turned it off.  We strongly encourage users to leave auto-update turned on 
and to accept auto-updates when they occur. Note, to allow auto-update under Windows 
Vista, use the right mouse button when clicking on the Leopard icon, and select “Run as 
Administrator.”  You can click on the icon and run Leopard normally thereafter. 
 

6 General Information 

6.1 Client-Server Software Interactions 
The Leopard software that you download onto your computer acts as the ‘client’ and 
requests information over the network from the ‘server’ software located at the SSC. An 
Internet connection to contact the servers is required to query the Spitzer data Archive, 
download Spitzer data, and download astronomical images and catalogs.   
When the servers are accessible by Leopard, the net-up symbol (Figure 1) will appear at 
the bottom of the main Leopard window.   

    

Figure 1: The net-up symbol means Leopard can access the SSC servers. The net must be up to query 
the Spitzer data Archive, retrieve data, or download images or catalogs.  

If your computer is not connected to the Internet, or if our servers are temporarily down 
(usually for a time on Tuesdays for maintenance), the net-down symbol (Figure 2) will 
appear at the bottom of the main Leopard window.  
 

  

Figure 2: The net-down symbol means Leopard cannot access the SSC servers.  

Check the Release Notes if you are using a Windows PC and never see the net-up 
symbol.  This has been noted in two instances and the fix is described in the Release 
Notes.  If you see the net-down symbol and believe that Leopard should be connected to 
the servers, please send email to the Spitzer Science Center Helpdesk at 
help@spitzer.caltech.edu.  We do not provide 24-hour support for the SSC servers. We 
have computer support available weekdays during business hours, so if our servers go 
down late Friday evening, they may not come back up until Monday morning.   
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6.2 On-line Help and Tool Tips 
In addition to the Release Notes and this User’s Guide, on-line help for Leopard is 
available from the Help menu in the main Leopard window. There are also help buttons 
throughout the program that connect directly to applicable help files.  
 
On-line help is also available in the form of ‘tool tips,’ one-sentence messages that 
appear whenever the cursor is placed over a field or button for longer than 3 seconds 
(Figure 3).  Tool tips are used to define acronyms, expand abbreviations, and provide 
data entry instructions.  
 

 
Figure 3: A “tool tip” is displayed by placing the cursor over the “X Marks the Spot” icon.  This icon 
brings up the dialog to query the archive by position. 

6.3 Troubleshooting 
The current list of known bugs and issues is updated regularly and kept on the Proposal 
Kit web page from which you downloaded this software.  If you think you have found a 
bug, before reporting it, please check the bugs list and the troubleshooting section of the 
Release Notes to discover if it is a ‘feature’ we already know about. Also check the 
appropriate section of this Guide to understand what the software is doing.   
 
If you find a real bug, then please do let us know about it. 
 
1.  Email a description of the problem to the Spitzer Science Center Helpdesk at 
help@spitzer.caltech.edu.  
2.  Include the hardware configuration you are using (e.g., SunBlade 100, 512 MB). 
3.  Please attach the Leopard log file.  Each time you run Leopard it creates a file called 
‘leopard_DATE_TIME.log’.  The log files can be found in the default directory created 
when you install the software.  The default directories are (yes, in the spot directory. 
There is no separate leopard directory for these files.): 
 
Solaris/Linux/Mac    /home/<username>/.spot 
Windows ME       c:\spot 
Windows NT/2000/XP  c:\Documents and Settings\{username}\Application Data\Spot 
Windows Vista              c:\Users\[username]\AppData\Roaming\spot 
 
The text showing in any error windows that pop up in Leopard should show up in the log 
file as well. 
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7 Leopard Menus  
 
Leopard has nine menus that provide the tools needed to access the Spitzer Archive. 
section 7.11 gives a single page summary of all the Leopard menu items. The menus 
provide the following functions. 

7.1 File Menu  
The main querying windows are accessed from this menu.  

7.1.1 Download Selections  [ctrl-D] 
This menu item becomes active if you have selected data to download from the Archive. 
Use it to begin the download process.  You now can opt to unpack and delete the archive 
zip file:  Click on “Unzip and Delete after downloading” in this dialog window. 

7.1.2 Save AOR List 
Once you have performed an archive query, you can save to local disk the Archive Query 
Results shown in the main Leopard window.  The dialog that opens when you select this 
utility is shown in Figure 4.   
 

 
Figure 4:  The dialog for saving to local disk a text file containing the Archive Query Results listed in 
the main Leopard window. 
 
The actual format of the output contained in the file will look like the example shown 
below. 
 
#  List of AORs from Spitzer Archive 
#  Generated by Leopard on:  10/20/2005     15:51:30 
 
  PID     ReqKey    AOT Type           Status       Release Date       Coordinates         Target Name 
 
  159    5504000  IRAC Mapping         nominal      Jun-24-2004  13h29m56.71s,+47d13m12.6s  NGC5194_95 
  159    5504256  IRAC Mapping         nominal      Jun-24-2004  13h29m56.71s,+47d13m12.6s  NGC5194_95 
  159    5572608  MIPS Scan Map        nominal      Aug-06-2004  13:29:52.7,+47:12:13       NGC5194_95 
  159    5572864  MIPS Scan Map        nominal      Aug-06-2004  13:29:52.7,+47:12:13       NGC5194_95 
  159    5594624  MIPS SED             nominal      Jun-14-2005  13:29:52.7,+47:11:43       NGC5194 
  159    5594880  MIPS SED             available                 202.49833333333333d,47.26  NGC5195 
  159    9480192  IRS Mapping          nominal      Jul-02-2004  13h29m52.7s,+47d11m43s     NGC5194 
  159    9487360  IRS Mapping          nominal                   13h29m59.6s,+47d15m59s     NGC5195 
  159    9492992  IRS Mapping          nominal      Jul-02-2004  13h29m59.6s,+47d15m59s     NGC5195 
 159    9512704  IRS Mapping          nominal      Jul-02-2004  13h29m52.7s,+47d11m43s     NGC5194 
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7.1.3 Save Current Plotted Image as FITS file 
If you are currently displaying an image in Leopard selected from the Images menu, this 
will save the image as a FITS file.  It does not save any overlays, just the image.  

7.1.4 Save Current Plotted Image & Overlays to JPEG, GIF, BMP, or PNG 
If you are currently displaying an image in Leopard selected from the Images menu, this 
will save the image, along with any overlays, as a GIF, JPEG, BMP (bitmap), or PNG 
format file. 
 

 
Figure 5: The Query Archive dialog, showing the inputs for a box search, where you specify the sky 
positions of the bottom left and upper right corners of the box. 

7.1.5 Login to Spitzer Archive  [ctrl-L] 
Use this function to log into the Spitzer Archive to retrieve proprietary data. You must be 
the PI or Technical Contact of an approved Spitzer program to log into the archive. Users 
requesting Spitzer data in the public domain do not need to log into the Spitzer Archive. 
When logged in, your account information is shown in the bottom left corner of the 
Leopard main window. 

7.1.6 Logout from Spitzer Archive  [ctrl-O] 
Use this function to log out from the Spitzer Archive. Leopard will ask if you are sure 
you want to log out. Select OK to complete the log out process.  
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Figure 6: The Query Archive dialog, showing the inputs for a four points search, where you specify 
the positions of the four points of a region on the sky. 

 

 
Figure 7: The Query Archive dialog, showing the inputs for a search for a moving target, where you 
specify the NAIF name or ID of the target. 
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7.1.7 Change Password to Spitzer Archive  [ctrl-W] 
This function allows you to change your Spitzer Archive password. You must be logged 
into the Spitzer Archive for this function to be active. Enter your old password, new 
password, and confirm the new password. 

7.1.8 Quit  [ctrl-Q] 
Select this option to exit the Leopard program. 

7.2 Query Menu 

7.2.1 By Position  [ctrl-U] 
This function opens a window to allow entry of Archive query parameters.  You can now 
perform not only a cone search with a user-specified radius (default, 5′) around a target 
position (see Figure 52), but also search with a box where you have specified the sky 
positions of the box’s bottom left and upper right corners (Figure 5), a search within four 
sky position points (Figure 6), and a search by NAIF ID (Figure 7).  For a cone search, it 
is recommended that you not simply use a target name for an Archive query, but resolve 
the name, via NED or SIMBAD, to obtain the actual target position, or enter the position 
by hand. This is because approved Spitzer observing programs are NOT required to use 
standard or well-known target names in their AORs.  

7.2.2 By Program 
If you know the Program ID number of a specific observing program, you can query the 
archive for data from that program using this query archive dialog (see Figure 54).  

7.2.3 By AOR ID  [ctrl-R] 
If you know the unique AOR ID (aka AOR Key or Request Key) of a Spitzer 
observation, you can use this dialog window to quickly enter the number and retrieve 
information from the Archive about that AOR. 

7.2.4 By Campaign/Observer 
You can search for all the data from a given instrument campaign (Figure 9).  Leopard 
will return with a dialog window with a list of programs observed during that campaign.  
To choose a program or programs from the list, click “Selected” next to the Program ID 
number and then click “OK.” 
 
Either for all campaigns or for a given campaign, you can also search for all the data 
obtained by a given observer (Figure 9).  Observers’ names are listed in alphabetical 
order.  Simply click on an observer’s name in the pulldown list.  Leopard will return with 
a dialog window with a list of programs corresponding to that observer.  To choose a 
program or programs from the list, click “Selected” next to the Program ID number and 
then click “OK.”  Note: Currently all names beginning with “de,” “van,” and “von” are 
toward the end of the list. 
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7.2.5 FLS and Legacy Programs  [ctrl-P] 
This function opens a dialog to allow you to select the AOR IDs and non-proprietary data 
products from the First Look Survey and all 26 Legacy Science Programs. 

7.2.6 AOR ID List Query  [ctrl-S] 
The user can query the Spitzer Archive by reading in a file containing a list of unique 
AOR IDs (AOR Keys or Request Keys).  The AORs will be grouped into a list of 
programs that contain those AORs.  The user can select the desired AORs from the 
program(s) in the main Leopard window.  The format of the input ascii file is simple.  
Request keys are listed one per line; lines which start with “#” are treated as comments.   
 

 
Figure 8: The Campaign/Observer Query Archive dialog, showing the input for a search by a given 
observing campaign. 

 

 
Figure 9: The Campaign/Observer Query Archive dialog, showing the input for a search by specific 
observer. 

An example: 
 
# this is the list of user-specified AOR IDs (request keys) 
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1234567 
2345678 

7.2.7 Fixed Target List Query 

Leopard can read in a list of fixed (inertial) targets and then query the Spitzer Archive for 
each target entry in the list.  A sample file is shown below and the required format of the 
file is described.  Leopard will name resolve from the target list: The keyword “NAME-
RESOLVER,” can be input at the top of the list, with values either “ned” or “simbad.” If 
the target list with this keyword included contains a line consisting only of a target name, 
the name resolver is contacted via the Internet to retrieve the positional information.  
Additionally, an optional search radius, in arcminutes, can be input with keyword 
“RADIUS.”  The default search radius is 1′.  As a new feature, the last column of the list 
query can be used optionally to specify an individual instrument (i.e., IRAC, MIPS, IRS) 
or an individual AOT or mode (e.g., MIPS-SED, IRS Spectral Mapping SL2).  
An example target list looks like the following: 
 
COORD_SYSTEM: Equatorial         # Equatorial (default), Galactic, or Ecliptic  
EQUINOX: J2000                             # B1950, J2000 (default), or blank for Galactic 
NAME-RESOLVER: NED               # NED or Simbad (default)  
RADIUS: 3                                        # RADIUS is in unit arcmin 
# 
# The possible Instrument/AOT types (INS_AOT) and syntax are:  
# MIPS, MipsPhot, MipsScan, MipsSed, MipsTp,  
# MIPS24, MIPS70, MIPS160 
# MipsPhot24, MipsPhot70, MipsPhot70Fine, MipsPhot160 
# 
# IRAC_ALL, Irac, IracPC  (NOTE: The IracPC mode is currently unavailable!) 
# IRAC_ALL1, IRAC_ALL2, IRAC_ALL3, IRAC_ALL4 
# Irac1, Irac2, Irac3, Irac4 
# IracPC1, IracPC2  
# 
# IRS, IrsMap, IrsStare, IrsPeakupImage 
# IRS_SL, IRS_SL1, IRS_SL2, IRS_LL, IRS_LL1, IRS_LL2, 
# IRS_SH, IRS_LH, IRS_PU 
# IrsStare_SL, IrsStare_SL1, IrsStare_SL2, IrsStare_LL, IrsStare_LL1, IrsStare_LL2, 
# IrsStare_SH, IrsStare_LH, IrsStare_PU 
# IrsMap_SL, IrsMap_SL1, IrsMap_SL2, IrsMap_LL, IrsMap_LL1, IrsMap_LL2, 
# IrsMap_SH, IrsMap_LH, IrsMap_PU 
# 
#Name     RA/LON       DEC/LAT     PM-RA PM-DEC EPOCH   INS_AOT 
"NGC 001" 12h34m23.45s 34d23m56.2s 2.3    3.4 1950.3    MIPS 
"NGC 001" 12h34m23.45s 34d23m56.2s 2.3    3.4 1950.3    MIPSSED 
NGC2222   23.56d       34.456d     2.3    3.4 1950.3    IRAC 
NGC3333   23.56h       34.456d     2.3    3.4 1950.3    IRS 
NGC3333   23.56h       34.456d     2.3    3.4 1950.3    IRSMAP 
NGC3333   23.56h       34.456d     2.3    3.4 1950.3    IRSSTARE 
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NGC4444  "12 34 12.23" "34 23 45.45" 
m31 
legacy  "17 18 00" "59 30 00" 
m32 
m33       simbad 
 
• The first two keywords give the coordinate system and equinox for all the positions in 

this list; these keywords are optional. 
• The list columns are separated by spaces. If there are spaces in the values for a 

column, double quotes are needed surrounding the value.  This is particularly true for 
name resolving. 

• Any lines starting with the pound sign (#) will be treated as comments.  
• Proper motion for RA and DEC, in arcseconds, are not required, may only be entered 

for Equatorial coordinates, and must always be supplied in RA and Dec pairs.  
• If the value for the fourth column is larger than 1900.0, it is interpreted as the epoch. 

If it is smaller than 1900.0 it is assumed to be a proper motion, as discussed above. 
The epoch field need only be entered for equinox B1950 coordinates. 

• You need to make separate lists/files for Equatorial J2000, Equatorial B1950, 
Galactic, Ecliptic J2000, and Ecliptic B1950 coordinates, because the first two 
keywords define the coordinate system for the entire file.  These can then be read into 
Leopard one file at a time. 

• If only a name is listed in the first field, and a name resolver is specified (in the 
example above, “ned”), the resolver will be contacted for positional information.  
NED has a more forgiving name resolver, so a name string without spaces, e.g., 
“NGC4321,” can be resolved.  However, with SIMBAD, if a target name has a space, 
don’t remove that space; instead, place the whole name string within double quotes 
for the resolver to work. 

You can create targets in the format required by Leopard with a text editor and then read 
in these files. 

7.2.8 Moving Target List Query 
Leopard can read in lists of single moving targets. The format for the input file must 
follow these rules: 
 
• Comments must start with # or !. 
• Each line should have at most 2 elements. The first element is the NAIF Name and 

the second is the NAIF ID if both elements are present. 
• If only one element is provided, it is assumed to be the NAIF ID if it is all numbers 

(put it in double quotes, if it is a name). If the one element has characters other than 
numbers, it is assumed to be the name. 

• If there are spaces in the name, put the entire name inside double quotes. 
• The NAIF ID should NOT be in quotes. 
If only one element is on the input line, Leopard will attempt to resolve the missing 
Name or ID. Spot will issue a warning message if a given name does not resolve a NAIF 
ID (and no entry for the object will appear in the target list). If both Name and ID are 
provided, both will be used as they appear on the input line. 
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An example moving single target list looks like the following: 
 
“my targ name” 12345678 
Mars_barycenter 4 
Dione 2000106 
604 
2000159 
Jupiter 

7.2.9 Popular Products Query 
This function opens a window to allow you to select general Popular Products in the 
archive, including original Legacy Science Program data by campaign and enhanced data 
products, First Look Survey (FLS) data products, and certain GTO program data 
products. 

7.2.10 Query Legacy Ancillary Data Archive  [ctrl-A] 

This function opens a window to allow you to select original Legacy Science Program 
Ancillary Data from the Archive.  2MASS Lockman Hole, FLS, and SWIRE ancillary 
data are currently available for download. Clicking on the Region Overview buttons on 
the right side of the window brings up another window that shows the regions covered in 
the surveys. 

7.3 Edit Menu  

7.3.1 Delete selected AORs  [ctrl-X, delete] 
This function will be active if AORs are selected in the Archive Query Results window.  

7.3.2 Delete Checked Popular/Ancillary Data 
This function will delete all Popular Product or original Legacy Science Program 
Ancillary Data that are selected in the Archive Query Results window.  

7.3.3 Delete All AORs 
This will clear ALL of the AORs in the Archive Query Results window. This action is 
NOT reversible. 

7.3.4 Delete All Targets 
This will clear ALL of the targets in the Target List. This action is NOT reversible. 

7.3.5 Update All AORs 
This will update the information (e.g., release date) for all the AORs currently listed in 
the Archive Query Results window.  (This is a handy utility if you tend to leave Leopard 
open continuously over long time periods.) 
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7.3.6 Hide AORs with no Archive Data 
If selected, only those AORs with Archive data will be displayed in the Archive Query 
Results window. 

7.3.7 Filter Archive AOR Results 
The AORs displayed in the Archive Query Results window can be filtered by date 
(Figure 10).  The default setting is for no filtering.   Filtering can be either by release date 
(the date on which the data from the AORs become public) or by schedule date (the date 
on which the AORs were executed).  You can also select AORs from a single campaign 
by entering the start and end dates for that campaign.  The format for entering the dates is 
“year month day,” e.g., 2005 Jan 15. 
 

 
Figure 10:  The dialog for setting the filtering by date of the list of AORs shown in the Archive Query 
Results window. 

7.3.8 Mark all AORs as not Queued or Downloaded 
Leopard remembers which AORs have been downloaded in one session. If you want to 
download the same data products again this function will start the download over again. 

7.3.9 Undo  [ctrl-Z] 
This function undoes the last action performed by Leopard. 

7.4 Select Menu 
This function allows you to select or unselect all or parts of AORs for each of the three 
instruments – IRAC, IRS, and MIPS. 

7.4.1 Enable All Selected  [ctrl-E] 
Select all the wavelengths for all the AORs that are highlighted in the main Leopard 
window. 

7.4.2 Disable All Selected 
Unselect all the wavelengths for all the AORs that are highlighted in the main Leopard 
window. 
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7.4.3 Enabled IRAC 
Select all or some of the wavelengths for all the IRAC AORs that are highlighted in the 
main Leopard window. 

7.4.4 Disabled IRAC 
Unselect all or some of the wavelengths for all the IRAC AORs that are highlighted in 
the main Leopard window. 

7.4.5 Enabled MIPS 
Select all or some of the wavelengths for all the MIPS AORs that are highlighted in the 
main Leopard window. 

7.4.6 Disabled MIPS 
Unselect all or some of the wavelengths for all the MIPS AORs that are highlighted in the 
main Leopard window. 

7.4.7 Select All IRS 
Select all available modules for all the IRS AORs that are highlighted in the main 
Leopard window. 

7.4.8 Unselect All IRS 
Unselect all available modules for all the IRS AORs that are highlighted in the main 
Leopard window. 
 
As the user selects/deselects AORs, the check boxes in the Retrieve Wavelengths field in 
the main Leopard window will reflect this. 

7.5 Info Menu 

7.5.1 Detail Information  [ctrl-I] 
This function opens a window displaying the detailed observing parameters, data 
products size, programmatic information, and data quality comments for the selected 
AOR. 

7.5.2 Target List 
This function brings up a window containing the target information for AORs in the 
Archive Query Results window. 

7.5.3 Spitzer Archive History 
This provides a chronological list of milestones for the Spitzer Archive that may be of 
interest to the user.  

7.5.4 Memory Monitor 
This dialog shows how much memory (bytes) JAVA has allocated (total memory) and 
how much of that allocation is currently available (free memory). We are using this 
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mainly as a debugging tool to determine when JAVA is having trouble with the memory 
allocation, mainly on Sun Workstations. 

7.6 Images Menu 
Images from a variety of different wavelengths of your target region can be downloaded 
and displayed within Leopard.  Catalog, coordinate grid, Spitzer focal plane, target 
position, and AOR area coverage overlays are available from the Overlays Menu.  The 
visualization functionality is discussed in section 9.  Leopard reads and writes FITS 
format files. The images available are: 
 

 
 

Figure 11: The ISSA/IRIS dialog that allows selection of IRAS images for display in Leopard. You 
may select 12, 25, 60, and/or 100 µm images.  Three choices for how the images are displayed are 
available from the “Where?” box.  You enter the size (1°--12.5°  on a side) and the initial zoom level.  
You can also create three-color (RGB) image composites. 

7.6.1 ISSA/IRIS – IRAS Sky Survey Atlas  
The ISSA images are IRAS Sky Survey Atlas maps at 12, 25, 60, and 100 µm that will 
help you characterize the sky at mid-infrared wavelengths. Note however, that these 
images have had zodiacal light contributions removed. A newer generation of IRAS 
images, called IRIS, benefits from better zodiacal light subtraction, calibration, better 
destriping, and zero levels compatible with DIRBE. As a new feature of Spot, these 
images are also now available.  For more details about IRIS, see 
http://www.cita.utoronto.ca/~mamd/IRIS/. Input the desired image size (in arcseconds, 
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arcminutes, or degrees), and select the desired initial zoom level (no zoom, “2X,” “3X,” 
etc.). These images are served directly from IRSA, the InfraRed Science Archive 
(http://irsa.ipac.caltech.edu/). 
 

 
 

Figure 12: The dialog that allows selection of 2MASS J, H, or Ks-band images for display in Leopard. 
You enter the size (50″–500″ , 0.83′–8.33′ , or 0.014°–0.139°  on a side) and the initial zoom level.  You 
can also create three-color (RGB) image composites. 
 
The dialog for ISSA/IRIS image selection is shown in Figure 11.  The target buttons 
allow you to select or change the desired target region. Three choices for how the images 
are displayed are given in the “Where?” box.  The default is to put each image into its 
own frame.  All the plots may alternatively be put into the same frame, stacked on top of 
each other. This saves space on a small screen.  You can also create three-color 
composite images in Leopard (see section 9.1.5). 
 
The displayed ISSA/IRIS image may not be the full size requested. The images are stored 
and returned as ‘plates’ with a limited overlap.  The ISSA/IRIS server picks the best plate 
by maximizing the distance from the target to the nearest edge of the plate.  This edge 
may still be close enough to the target that the displayed image will appear to have one 
side "shaved off", or the target may not be centered in the image but off to one side.   
 
If you already have existing images displayed, you may also select to have the new ones 
stacked into that frame.  If you utilize this feature, you must remember that the plate 
scales for the images from the different servers are very different.  For instance, 
ISSA/IRIS images are 1°–12.5° on a side, while 2MASS images are 50″–500″ on a side.    
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7.6.2 2MASS – Two Micron All Sky Survey  
The 2MASS images are also served from IRSA.  You can select J, H, and/or Ks band.  At 
this time, large area mosaics of the images are not available; only single Atlas Images 
will be retrieved in the region specified.  Even though these are full-fidelity images, they 
should not be used directly for photometry. Use the 2MASS catalogs for detailed source 
information. The image selection dialog is shown in Figure 12.  Choices in target, image 
size, image location, zoom, and three-color composites, analogous to those for the ISSA 
images, are available.  

7.6.3 MSX – Midcourse Space Experiment 
The MSX A, C, D, and E mid-infrared images are provided here. The image selection 
dialog is shown in Figure 13.  For more information on the MSX mission, see 
http://www.ipac.caltech.edu/ipac/msx/msx.html.  Choices in target, image size, image 
location, and zoom, analogous to those for the ISSA images, are available. 
 
At this time, all MSX FITS headers define Galactic North to be “up.” As such, MSX 
images may appear to be rotated with respect to other images that define Equatorial North 
to be “up.”  Leopard does not rotate images, but AOR overlays will appear the way they 
will be observed, regardless of coordinate system. 

7.6.4 DSS – Digitized Sky Survey  
The optical Palomar Sky Survey images are provided here. They are served from the 
Space Telescope Science Institute (http://archive.stsci.edu/cgi-bin/dss_form). The image 
selection dialog is shown in Figure 14.  Choices in target, image size, image location, 
zoom, and three-color composites, analogous to those for the ISSA images, are available.  
If you require an image larger than 30′ on a side, please get it directly from the DSS web 
page and then load it as a local FITS file (section 7.6.9). 

7.6.5 SkyView – SkyView image data 
The multiwavelength SkyView ground- and space-based image data are provided here. 
They are served from NASA’s High Energy Astrophysics Science Archive Research 
Center (HEASARC; http://heasarc.gsfc.nasa.gov). The image selection dialog is shown in 
Figure 15. Choices in target, image size, image location, zoom, and three-color 
composites, analogous to those for the ISSA images, are available.  Variable image size 
limits apply.  For some image data, if you require an image larger than Leopard’s 
maximum limit for those data, please get the image directly from the HEASARC web site 
and then load it as a local FITS file (section 7.6.9). 

7.6.6 NED – NASA/IPAC Extragalactic Database 
Leopard will display a list of images that are available for the target from NED 
(http://nedwww.ipac.caltech.edu).  The search uses the target name, not the target 
coordinates to locate an image in the database. An example is shown in Figure 16.  If 
Leopard cannot find the image by target name, you will have to retrieve it directly from 
NED and load it as a FITS file (see section 7.6.9). 
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Figure 13: The dialog that allows selection of MSX A, C, D, and E-band images for display in 
Leopard. You enter the size (360″–5400″ , 6′–90′ , or 0.1°–1.5°  on a side) and the initial zoom level.  
You can also create three-color (RGB) image composites. 
 

 
Figure 14: The Digital Sky Survey image selection dialog is shown. You enter the size (57.6″–1800″ , 
0.96′–30′ , or 0.016°–0.5°on a side) and the initial zoom level.  You can also create three-color (RGB) 
image composites. 
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Figure 15:  The SkyView image selection dialog is shown. You enter the size (in arcseconds, 
arcminutes, or degrees on a side) and the initial zoom level.  You can also create three-color (RGB) 
image composites. 
 

 
Figure 16: The listing of the images available from NED for the example target name (M31). You 
enter the initial zoom level.  You can also create three-color (RGB) image composites. 



Leopard User’s Guide v9 
 

June 18, 2008 27 

7.6.7 ISO Archive 

Leopard will display a list of images that are available for the target from the Infrared 
Space Observatory (ISO) Data Archive (http://www.iso.vilspa.esa.es/ida/).  This service 
is still preliminary and will be improved in future releases. For the moment, only the 
ISOCAM CAM01 photometric images are served.  An example is shown in Figure 17. 

 
Figure 17: The listing of the images available from the ISO Archive for the example target name. 
You enter the initial zoom level.   You can also create three-color (RGB) image composites. 
 

 
Figure 18: When searching for NVO images near your target position, first specify the size of the 
region of interest over which Spot can search. 

7.6.8 NVO Image 
Leopard will now retrieve images from repositories registered with the National Virtual 
Observatory (NVO). The images are queried and retrieved via Simple Image Access 
Protocol (SIAP), defined in http://www.ivoa.net/Documents/WD/SIA/sia-20040524.html. 
When you first select this option, a dialog, as shown in Figure 18, opens, in which you 
can enter the size of the region of interest around your target in decimal degrees.  You 
can then narrow the NVO query by spectral coverage, as shown in Figure 19; the default 
is “Multi,” for multiwavelength coverage.  You can further narrow the search to available 
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matching resources for the chosen spectral coverage, as shown in Figure 20.  Then, click 
OK. 
 
Each SIAP site is queried individually, one by one. The list of matching resources grows 
as sites are queried.  The image search can take several minutes to complete. The search 
is performed in the background and does not prevent you from performing other 
operations. 
 
 

 
Figure 19: The available options for spectral coverage when searching for NVO images near your 
target position. You enter the initial zoom level. You can also create three-color (RGB) image 
composites. 

7.6.9 FITS File 
Leopard can also display any images that have been obtained from another image server 
or that you have taken yourself. Leopard also reads gzipped FITS files and FITS files 
with extensions.  There must be world coordinate system keywords in the header for the 
positional information to be accurately read.  Data from most modern telescopes should 
be handled well.   Note that the available computer system memory limits the size of a 
FITS image that may be loaded into Leopard.  Loading large FITS images may 
compromise the memory left available for other Leopard functions. The images selection 
dialog is shown in Figure 21. 
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Figure 20: The available list of NVO image resources for the given spectral coverage that you have 
selected, as shown in Figure 19. You can enter the initial zoom level. You can also create three-color 
(RGB) image composites.  Click “OK” to complete the image search. 
 

 
Figure 21: The image selection dialog for reading in a local FITS file. This utility will also read in 
gzipped FITS files and FITS files with extensions.  You can enter the initial zoom level.  You can also 
create three-color (RGB) image composites. 

7.6.10 FITS file from URL 
Leopard can also now display FITS images available from any web-based image server 
for which an address can be specified by a Universal Record Locator (URL). Spot also 
reads gzipped FITS files and FITS files with extensions.  There must be world coordinate 
system keywords in the header for the positional information to be accurately read.  Data 
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from most modern telescopes should be handled well.   Note that the available computer 
system memory limits the size of a FITS image that may be loaded into Spot.  Loading 
large FITS images may compromise the memory left available for other Spot functions. 
The images selection dialog is shown in Figure 22.   
 

 
Figure 22: The image selection dialog specifying the URL of a FITS file. This utility will also read in 
gzipped FITS files and FITS files with extensions. You can create three-color (RGB) image 
composites. 

7.6.11 All Sky Images  
Select from DIRBE 4.9, 60, and 140 µm and ISSA All Sky Images. These are particularly 
useful for visualizing moving targets with high apparent rates.  The selection dialog is 
shown in Figure 23.    Note that the ISSA All Sky Image is a low-resolution IRAS 
composite which has been smoothed to 0.5°×0.5° resolution.  Unlike the individual ISSA 
plates, it contains the zodiacal background component, but it should not be used for 
background estimates if small-scale structure is important. The DIRBE images do 
provide reliable background estimates for the Galactic and extragalactic background 
components, and are accurate for the zodiacal light background expected if you observe 
your target at 90° solar elongation.  However, if you observe your target near the inner 
edge of the OPZ at 80° solar elongation, the real zodiacal light values could be higher by 
approximately 20%. If the object is observed at the outer edge of the OPZ at 120° solar 
elongation, the real zodiacal light values could be fainter by 50%, when compared with 
the value read from the map. If accurate background estimates are crucial for your 
observation, we STRONGLY recommend that you use the values obtained from 
“Background” button in the Target window. 
 

 
Figure 23: The selection dialog for All Sky Images. 
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7.6.12 Blank Image 
Leopard can also now provide a blank “background” image on which to display overlays 
(see section 7.7). The width and height, in pixels, of the blank image can be specified.  
The pixel scale can be set as either the native Depth of Coverage overlay pixel scale, the 
2MASS image pixel scale, the ISSA plate scale, or any other pixel scale you specify. The 
images selection dialog is shown in Figure 24. 
 

 
Figure 24: The selection dialog for specifying a blank image.  You can select the size of the image in 
pixels, as well as the pixel scale. You can create three-color (RGB) image composites. 

7.7 Overlays Menu 
 

 
Figure 25: Leopard currently serves six IPAC catalogs that can be overlaid onto the image display. 

7.7.1 Catalogs from IPAC  
Leopard currently serves six catalogs from IPAC servers whose sources can be overlaid 
onto the image display. From the dialog (Figure 25) you select the catalog and 
appropriate search radius for sources. These catalogs are served from IRSA, like the 
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ISSA and 2MASS images. The text catalogs are cached, like the images, to your 
designated cache directory. 

7.7.2 Catalogs from HEASARC 
Leopard currently serves a large number and range of catalogs from HEASARC whose 
sources can be overlaid onto the image display.  From the dialog (Figure 26) you select 
the catalog and appropriate search radius for sources.  The text catalogs are cached, like 
the images, to your designated cache directory (see section 7.8.6). 
 

 
Figure 26: Leopard currently serves catalogs from HEASARC that can be overlaid onto the image 
display. 

7.7.3 Catalogs from VizieR (beta) 
As a new feature, Leopard now serves a large number and range of catalogs from VizieR 
whose sources can be overlaid onto the image display.  From the dialog (Figure 27) you 
select the catalog and appropriate search radius for sources.  The text catalogs are cached, 
like the images, to your designated cache directory (see section 7.8.6).  This catalog 
access is in a beta version; you should limit the size of your search radius (less than 100″, 
unless the data content is small) and only works with target names that are Simbad 
resolvable. 

7.7.4 Catalog File  
Leopard can also overlay a catalog file from a local disk if it is in the modified IPAC 
table format. A description of the modified IPAC table format is provided below. From 
the dialog (Figure 28) you select the catalog file.  The file should have the ‘tbl’ extension 
so that Leopard knows it is an IPAC table. The format is comprised of three parts: 
keywords, column headers, and data in columns. 
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Figure 27: Leopard currently serves catalogs from VizieR that can be overlaid onto the image 
display. 
 

 
Figure 28: This dialog will allow you to select a local catalog file, in the modified IPAC table format, 
to overlay onto your images. 

7.7.4.1 Keywords 
Keywords start with a back-slash (\).  There should be no space between the back-slash 
and the keyword.  For example: 
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\ORIGIN = 'IPAC Infrared Science Archive (IRSA), Caltech/JPL'  
\fixlen = F  
\RowsRetrieved = 215  
 
The required keyword is \RowsRetrieved that tells how many lines of data are in the file. 
The keywords are placed first in the file, and they must be followed by column header 
lines.   

7.7.4.2 Column Headers 
The column headers describe the name, data type, and units of the tabular data.   
 
| name1     | name2  | 
| data type | double | 
| unit      | degrees| 
| null1     | null2  | 
 
The three required columns are: 
|        name|      ra|     dec| 
|        char|  double|  double| 
|            | degrees| degrees| 
|        null|    null|    null| 
 
All four column header lines are required.  Every column owns the rightmost bar, except 
for the first which owns two bars.   

7.7.4.3 Sample IPAC Table File 
 
\RowsRetrieved =                10 
 
|     fscname|      ra|     dec|   fnu_12|   fnu_25|   fnu_60| fnu_100| 
|        char|  double|  double|   double|   double|   double|  double| 
|            | degrees| degrees|       Jy|       Jy|       Jy|      Jy| 
|        null|    null|    null|     null|     null|     null|    null| 
F23545+2632   359.2639  26.8250     0.221     0.112     0.126    1.100 
F23548+2633   359.3554  26.8394     0.173     0.103     0.554    1.219  
F23567+2659   359.8219  27.2697     1.298     0.315     0.152    0.838  
F23568+2554   359.8425  26.1917     0.070     0.111     0.303    0.848  
F23574+2800   359.9940  28.2814     0.112     0.054     0.228    0.951 
F23561+2901   359.6731  29.3036     0.091     0.118     0.249    0.616  
F23570+2846   359.8954  29.0547     0.224     0.130     0.146    0.465 
F23554+2822   359.5090  28.6531     0.202     0.149     0.310    2.078 
F23555+2735   359.5287  27.8722     0.098     0.170     0.234    0.840 
 

Note: IRSA has developed a tool that will help you transform a regular ASCII table into 
IPAC table format.  See http://irsa.ipac.caltech.edu/applications/TblReformat. 

7.7.5 Crop 
This is not so much an overlay, as a means to crop the size of an image displayed in the 
Image window.  Crop creates a cropped copy of the image, while maintaining the original 
image.  See section 9.1.6.  Clicking on the icon in the image and overlay manipulation 
tool bar will activate this tool (see section 8.1).  
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Figure 29: The coordinate grid overlay dialog allows selection of the desired type of grid. 

7.7.6 Grid…a.k.a Coordinate Grid Overlay 
Leopard will overlay a variety of coordinate grids onto the image display.  From the 
dialog (Figure 29), you select the type of grid and where to display it.  You can also force 
Leopard to overlay a coordinate grid on every image displayed, as well as control the 
spacing of the grid lines. Clicking on the icon in the image and overlay manipulation tool 
bar will activate this utility. 

7.7.7 Distance Tool 
Once this item is selected, the left mouse button can be used to click and drag a line 
across a region on your image.  The length of the dragged line in selected units is then 
displayed both on the plot and in tabular form. Clicking on the icon in the image and 
overlay manipulation tool bar will activate this utility. 

7.7.8 Slice Tool 
This tool will produce a “slice” of an image, i.e., the radial distribution of flux as a 
function of position on the image. See section 9.6.  Clicking on the icon in the image and 
overlay manipulation tool bar will activate this tool. 

7.7.9 Area Statistics Tool 
As a new feature in Leopard, this tool will generate statistics from an image, i.e., the 
maximum, minimum, mean, and integrated fluxes, as well as the flux centroid and flux-
weighted centroid, within either a circular or rectangular user-specified area. See section 
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9.1.7.  Clicking on the icon in the image and overlay manipulation tool bar will activate 
this tool. 

7.7.10 Mark Object on Plot/User Created Catalog 
This tool allows to you selectively mark and label points of interest on your image plot. 
You can save the marks to a catalog file (in IPAC table format) to local disk.  This user-
created catalog later can be read back into Leopard to overlay. Clicking on the icon in the 
image and overlay manipulation tool bar will activate this utility. 

7.7.11 Current Fixed Target 
Leopard places a red box onto the current fixed target position in the displayed images. It 
also marks each offset position (in celestial coordinates) with a red plus sign if you have a 
cluster target type. Clicking on the icon in the image and overlay manipulation tool bar 
will activate this utility. 

7.7.12 Add Moving Target 
This option allows you to visualize the tracks of moving targets.  See section 9.7.4.9. 

7.7.13 Image Overlays 
You can overlay an ISSA, 2MASS, MSX, DSS, NED, or a FITS file from disk onto your 
current image. Wavelength or generation (DSS) options are the same as for normal image 
display.  See section 9.5.  
 

 
Figure 30: The dialog for overlaying the positions of all known moving objects within a given search 
radius at a given epoch on an image. 

7.7.14 Show All Known Moving Objects at a Date 
You can obtain a list of all the known moving objects within a given search radius (in 
arcseconds, arcminutes, or degrees) for a given field at a given epoch.  The search is 
conducted on the JPL Horizons database for moving objects. The retrieved list of moving 
objects is then overlaid on an image.  The dialog for specifying the search radius and 
epoch is shown in Figure 30.  An example image overlay is shown in Figure 31. 
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Figure 31: An example of the known moving object overlay.  In this example, seven asteroids are 
shown overlaid on the ISSA 12 µm plate. 
 

 
Figure 32: An overlay of the Spitzer Focal Plane is shown on an ISSA 25 µm image.  The desired 
position angle (e.g., 35), in degrees east of north, is entered into the field in the Focal Plane box. 
 



Leopard User’s Guide v9 
 

June 18, 2008 38 

7.7.15 Spitzer Focal Plane 
This item allows you to overlay the Spitzer Focal Plane at any position and specified 
angle onto the current image (Figure 32).  When selected, the focal plane is drawn over 
the current image, centered on the current target position, and a box of controls is added 
to the side bar of the current image. The position angle (degrees east of north of the 
projected Spitzer-to-sun vector) of the focal plane can be rotated by entering the value in 
degrees in the small entry field in the layer and hitting Return. To move the focal plane 
overlay to somewhere else in the image, click the mouse at the desired point in the 
current image.   
 

 
Figure 33: The configuration of the focal plane overlay is controlled from this dialog.  You can select 
the colors of the instrument FOV overlays and also select which FOVs are shown.  The pull down 
menu at the bottom allows you to select which instrument FOV will be centered on the image where 
you click the mouse. 
 
To change the colors of the instrument fields-of-view (FOV), where the focal plane is 
centered, and which instrument fields-of-view are shown, click the focal plane 
configuration  icon in the Spitzer Layer box on the sidebar. This brings up the dialog 
shown in Figure 33. You can turn off/on any instrument FOV or change their display 
colors here.  To select which FOV in the focal plane is centered where you click the 
mouse, use the pull down menu at the bottom of this dialog. Click on the diffraction spike 
control icon ( ) to display the spikes. The diffraction spikes move and rotate when you 
move or rotate the Spitzer focal plane.  

7.7.16 Generic Focal Plane 
This allows you to overlay a user specified square or circular ‘focal plane’ onto your 
image.  The dialog is shown in Figure 34.   
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Figure 34: The generic focal plane selection dialog allows the user draw a square or circle, of user-
selected size and orientation, onto an image. 

 
Figure 35: The dialog for selecting which AORs to overlay on an image. 
 

 
Figure 36: The dialog for plotting unscheduled AORs is shown.  It shows the visibility windows for 
the target, as well as a date in the middle of the next available visibility window (the default).  If you 
want to plot the AOR for a particular observation date within any visibility window, enter it here.  
Click on any visibility window to automatically select its mid-date.   Click OK for the overlay. 

7.7.17 AORs on Images 
This function allows you to overlay the area coverage for one or more AORs onto the 
displayed images. When AOR overlay is selected, the dialog shown in Figure 35 asks you 
which AORs to overlay:  the current one, only selected AORs, only AORs checked in the 
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Archive Query Results window, or all AORs currently loaded in Leopard.  Next, if an 
AOR has not yet been scheduled, the dialog window, shown in Figure 36, displays the 
visibility windows for the target, as well as a date in the middle of the next available 
visibility window.  If you want to plot the AOR for a specific observation date within any 
visibility window, enter that date here. Clicking on any visibility window will 
automatically select the mid-date in that window.  Or, just select the default.  Click OK 
for the overlay.  For an AOR that have already been executed, the overlay in Leopard will 
be done by default for the observation date for that AOR, and the visibility window 
dialog will not appear.   See section 9.7.  Leopard must be connected to the Internet to do 
the overlay, as it contacts the SSC AIRE and Visibility servers to get the correct 
orientation and sky positions for the overlay. 
 

 
Figure 37: The dialog for reading in a user-specified AOR map file. 

7.7.18 Read AOR Overlay Mapping File 

You can save the pointings table for an AOR overlay to local disk (see section 9.7.2).  
This file can be read back into Leopard at a later time for overlaying on images.  The 
dialog for reading the file into Leopard is shown in Figure 37.  Currently, only the 
overlay for one AOR at a time can be read in. 

7.7.19 Show Spitzer OPZ 
The OPZ is the Operational Pointing Zone. It defines where Spitzer can safely point and 
execute observations. When you select this overlay Leopard will bring up a dialog 
window and ask you to select an observation date (a default date is provided). Leopard 
will connect to the servers at the SSC to determine where the OPZ crosses your displayed 
image. If the OPZ does not cross the image, Leopard will ask if you would like to display 
an All Sky image to see how far away your displayed image is from the OPZ.  Leopard 
will then show you the OPZ on the All Sky image (Figure 38). 
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Figure 38: An overlay of the Spitzer Operational Pointing Zone (OPZ) on the All Sky image for the 
middate (2006 Sep 12) of the effective mission window. 
 
 

 
Figure 39: An overlay of bright objects is shown on an ISSA 12 µm image of a Galactic FLS field. 
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7.7.20 Spitzer Bright Objects for AOR 
Spitzer observations can be compromised by the presence of a bright object in or near 
your target field. You can obtain from the SSC database an overlay of the known bright 
inertial objects that may be within or near the field covered by an AOR. Detailed 
information and a very similar set of bright object lists can be found at 
http://ssc.spitzer.caltech.edu/documents/brightobj/.  Generally, these are objects that may 
have had a negative impact on the quality of the observations and possibly those that 
followed in the observing schedule.   For IRAC AORs, this utility searches for bright 
objects within a radius 10′ of the aperture center.  For IRS AORs, this utility searches 
more tightly to the area covered by the AOR, depending on the module (currently 
excluding Peak-up Imaging).  For MIPS AORs, it searches for bright objects within very 
nearly the exact area covered by a PH-SR, SED, Total Power, or Scan observation.  An 
example is shown in Figure 39, where bright sources have been overlaid on an ISSA plate 
of a field covered by one IRAC AOR of the Galactic FLS.  A detailed listing of these 
sources, including object name, position, and brightness information, can then be 
obtained, as shown in Figure 40.  The bright object data can then be saved to a file on 
local disk, by pressing the Save Table button and entering in the resulting dialog a file 
name and local disk directory.   
 

 
Figure 40: The detailed listing of bright objects shown in Figure 39.  

7.7.21 Show Depth of Coverage Maps on Current Image 
Depth of Coverage (DoC) maps allow you to visually see how many frames were taken 
in the area covered by an AOR, independent of any frame exposure time. You must be 
connected to the Internet to access the SSC servers to use this feature. For an AOR that 
has already been scheduled or executed on a particular date, Leopard will assumes this 
date for the overlay. Otherwise, you will be presented with the dialog window shown in 
Figure 41.  Enter a date of observation and choose which aperture(s) you wish to have 
mapped. Click ‘Ok’.  Leopard will access the SSC servers to determine the orientation of 
the map on the chosen observation date and overlay the DoC map. Drag the cursor over 
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the map. The number of frames covering each sky position will appear in the small 
window in the DoC layer (Figure 42). You can change the opacity (  icon) of the 
background image or overlay to more clearly see the depth of coverage map. Click the 
color table control (  icon) to select a different color table for the DoC map. 
 
Depth of Coverage maps do not work well near the poles. Our method of creating the 
depth of coverage maps creates misleading or incorrect results when the declination is 
greater than about ± 88°. More specifically, the method breaks down (the errors become 
noticeable) when the requested range of right ascension is greater than 10°. Leopard will 
return an error message if it detects that the user is requesting a depth of coverage map 
too near the poles. 
 

 
Figure 41: Dialog window for a depth of coverage map for a MIPS scan, as an example. The AOR 
Map Types shown in the lower right of the dialog will change depending on which apertures or 
modules are selected for the AOR. 

7.8 Options Menu 

7.8.1 Use Automatic Leopard Version Update  
The default for this is ‘Yes’. When enabled, if an update for Leopard is available, you 
will be asked if you would like to update your software (approximately 2 minutes after 
you start Leopard with an Internet connection). If selected, Leopard will download the 
update and install it on your computer. The update will ‘take effect’ the next time you 
start up Leopard (exit Leopard and start it again if you wish to access the update 
immediately), or when you allow Leopard to restart automatically.  It is recommended 
that you allow auto-updates. 

7.8.2 Sort by Dec, then RA 
This option allows you to sort the Target column in the Archive Query Results window 
first by declination, and then by right ascension.  Sorting on a column is achieved by 
clicking on the column heading (see section 8.2).  The default setting is to sort first on 
right ascension, and then declination. 
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Figure 42: Depth of coverage map for a 24 µm observation. The 'depth' of the map, or number of 
frames, is shown in the small box in the DoC layer as you move your mouse over the image. To more 
clearly see the DoC layer you can adjust the opacity icon of either the image or the DoC map.  Click 
the color table control icon to change the color table. 

7.8.3 Visualization:  Spitzer Focal Plane Options 
This option brings up the same dialog window as described in the Spitzer Focal Plane 
Overlay. Refer to section 7.7.14 and Figure 33 for details. 

7.8.4 Visualization:  Coordinate System Prefs 
This function allows you to select a default coordinate system displayed in the tables in 
Leopard. 

7.8.5 Visualization:  Readout Prefs 
When displaying an image, just below the main icon bar, Leopard returns three different 
pairs of values for the cursor position (Figure 43). On the far left is the flux or DN value 
for the pixel and the pixel scale. NOTE:  For the ISSA/IRIS images, these values are 
correct.  For the 2MASS images, the DN returned does not contain scientific value 
as these images have been lossy compressed.  Use the 2MASS catalogs for accurate 
scientific data values.  In the center and right boxes, two user-selected values are 
displayed for the present cursor position.  The Readout Prefs dialog is how you select 
those values.  For example, you can display the equatorial and ecliptic coordinates, or any 
coordinate system versus image pixel.  The read-out works for both the main image 
display and the thumbnail display shown to the right of the read-out boxes. 
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Figure 43: Display of the three different pairs of values for the cursor position on the image currently 
being displayed.  On the far left are the flux or DN value and the pixel scale.  In the center and right 
are displayed two different user selected coordinates.  The format of these two columns is selected 
from the Readout Prefs item in the Options menu.  

 
Figure 44: The size and location of the disk cache directory, where Leopard stores images retrieved 
from remote servers, is controlled from this dialog.  It is selected from the OPTIONS menu. 

7.8.6 Cache Prefs 
Leopard caches the images that it retrieves from remote servers to the local disk so that 
the images are available locally the next time you ask Leopard to display them.  This 
saves time and network traffic. The first time you retrieve an image, Leopard will ask you 
to designate a cache directory. You can change the location or size of the disk cache 
directory from this dialog (Figure 44). 

7.8.7 Network Proxy Setup 
If you select this option, you will see two options- Direct Connect to Internet and Manual 
Proxy Configuration.  If your institution has a firewall or proxy server in place you will 
want to select the Manual Proxy Configuration option and fill in the appropriate values 
for HTTP and HTTPS proxy ports and hosts, as well as proxy user name and password. It 
is recommended that you check with your systems administrator for the proper values 
though these can often be found by checking “Preferences”/”Options” and then 
“Advanced” and then “Proxies” in your internet browser. 

7.8.8 Use Large Control Icons 
This option makes larger the layer control icons for both images and overlays in the 
Images window, for better visibility. 

7.8.9 Visualization:  Show Mouse Help  [shift-ctrl-M] 
If you check this box, Leopard will display messages in the region above the Images that 
provide help for using the mouse.  For example, if you put your cursor over the image 
thumbnail (Figure 43, far right), it tells you that you can move the image by using the left 
mouse button.   
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7.8.10 Visualization:  Show Side Bar on Current Frame  [shift-ctrl-B] 
This allows you to manage your screen real estate.  If you are working on a very small 
screen, you may wish to turn off the sidebars, which allow you to manipulate overlays, on 
the right hand side of the current image. This option allows you to show and hide the 
sidebar. 

7.8.11 Visualization:  Show Side Bar on All Frames  [ctrl-B] 
This allows you to manage your screen real estate.  If you are working on a very small 
screen, you may wish to turn off the sidebars, which allow you to manipulate overlays, on 
the right hand side of all displayed images. This option allows you to show or hide the 
sidebars. 

7.9 Window Menu 

7.9.1 Archive Query Results 
This option allows you to bring forward the archive query results window, if it is not 
currently active in the main Leopard window.  This is very useful for managing Leopard 
if you are displaying several images and going back and forth between them and the 
Archive Query Results table.  

7.9.2 Open Images Windows 
This option allows you to bring forward the window of a currently open image, if it is not 
currently active in the main Leopard window.  The names of all images currently open 
and displayable in Leopard are listed in the Windows menu.  You can select each of these 
images with this option.  This is very useful for managing Leopard if you are displaying 
several images and going back and forth between them and the Archive Query Results 
table. 

7.10 Help Menu 

7.10.1 Overview 
This is the access point to the Leopard’s on-line help. Please also see the Leopard Release 
Notes, as well as the additional information available on the SSC Proposal Kit web page. 

7.10.2 Resources for Data Analysis 
This utility brings up a window that points you to the main website for all Spitzer data 
analysis resources (Figure 45). 

7.10.3 Tip Of The Day 
Controls the viewing of Leopard’s Tips. You can turn on/off the display of the Tip Of 
The Day. You can also browse through the Tips. 

7.10.4 About 
This function reports the version of Leopard running on your computer and URL and 
ports used to connect to the SSC servers. 
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In the next section we provide a summary list of the functions available from all of the 
Leopard menus. 
 

 
Figure 45: Selecting the Resources for Data Analysis under the Help menu brings up this window, 
listing the website for all Spitzer data analysis resources.
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7.11 Leopard v9 Menu Command Summary 
 

FILE MENU 
 Download Selections   [crtl-D] 
 Save AOR List 
 Save Current Plotted Image as FITS File 
 Save Current Plotted Image & Overlays to JPEG,GIF, BMP, or PNG 

Login to Spitzer Archive  [crtl-L] 
Logout from Spitzer Archive  [crtl-O] 
Change password to Spitzer Archive [ctrl-W] 

 Quit      [ctrl-Q] 
 

QUERY MENU 
By Position     [ctrl-U] 
By Program 
By AOR ID     [crtl-R] 
By Campaign/Observer 

 FLS and Legacy Programs   [ctrl-P] 
 AOR ID List Query    [ctrl-S] 

Fixed Target List Query 
Moving Target List Query 
Popular Products Query 

 Query Legacy Ancillary Data Archive [ctrl-A] 
 
EDIT MENU 

Delete selected AORs   [ctrl-X, Delete] 
Delete Checked Popular/Ancillary Data 

 Delete All AORS 
 Delete All Targets 
 Update All AORs 
 Hide AORs with no Archive data 
 Filter Archive AOR Results 
 Mark all AORs as not Queued or Downloaded 
 Undo      [ctrl-Z]  
 

SELECT MENU 
 Enable All Selected   [ctrl-E] 
 Disable All Selected 
 Enabled IRAC 
 Disabled IRAC 
 Enabled MIPS 
 Disabled MIPS 
 Select all IRS 
 Unselect all IRS 
 

INFO MENU 
 Detail Information   [ctrl-I] 
 Target List 
 Spitzer Archive History 
 Memory Monitor 
 
IMAGES MENU 
 ISSA Image 
 2MASS Image 
 MSX Image 
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 DSS Image 
 SkyView Image 
 NED Image 
 ISO Archive Image 
 NVO Image 
 FITS File Image 
 FITS file from URL 
 All Sky Images 
 Blank Image 
 

OVERLAYS MENU 
 Catalogs from IPAC 
 Catalogs from HEASARC 
 Catalogs from VizieR (beta) 
 Catalog File 
 Crop 
 Grid  [ctrl-G] 
 Distance Tool  [shift-ctrl-D] 
 Slice Tool 
 Area Statistics 
 Mark Objects on Plot/User created catalog 
 Current Fixed Target 
 Add Moving Target 
 Image Overlays 
 Show all Known Moving Objects at a Date 
 Spitzer Focal Plane 
 Generic Focal Plane 
 AORs on Images 
 Read AOR Overlay Mapping File 
 Show Spitzer OPZ 
 Spitzer Bright Objects for AOR 
 Show Depth of Coverage Maps on Current Image 
 

OPTIONS MENU 
 Use Automatic Leopard Version Update 
 Sort by Dec then RA 
 Visualization: Spitzer Focal Plane Options 
 Visualization: Coordinate System Prefs 
 Visualization: Readout Prefs 
 Cache Prefs 
 Network Proxy Setup 
 User Large Control Icons 
 Visualization: Show Mouse Help  [shift-ctrl-M] 
 Visualization: Show Side Bar on Current Frame  [shift-ctrl-B] 
 Visualization: Show Side Bar on All Frames  [ctrl-B] 
 

WINDOW  
 Archive Query Results 
 Open image windows… 
 

HELP 
 Overview… 
 Resources for Data Analysis 
 Tip Of The Day… 
 About… 
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8 Leopard Main Screen 

8.1 Icons  
Leopard uses several icons as shorthand for commonly used functions that are also 
available under the Menus.  They are shown in Figure 46. From left to right the icons are: 
 

 
Figure 46: The menus and icon bar on the Leopard main screen provide access to the various 
functions within Leopard. 

There are a number of Query Archive shortcut icons:  
 

 by Position by AOR ID List 

 by Program by List of Positions (fixed targets) 

 by AOR ID by List of NAIF IDs (moving targets) 

by Campaign/Observer for pre-packaged Popular Products 

for FLS/Legacy programs for Ancillary Data 
 
The other icons consist of: 
 

 Download the data to local disk.  

 Login to the Spitzer Archive (section 8.3.8). 

 Delete selected AOR from the Archive Query Results window. 

 Obtain detailed information about a highlighted AOR or ancillary data (sec. 8.3.9). 

 Brings up a window showing the target information for targets entered into Leopard 
or targets in AORs queried from the Archive (section 8.3.10). 
 
The image manipulation icons will appear on the left-hand side of the Leopard window 
whenever you display images (Figure 47). Click on the icons to activate them.  The 
magnifying glass icons are all for zooming your images in or out. This icon  zooms in 
the current image, and this one  zooms out.  These icons,  and , apply the zoom 
to all the images stacked in the active frame (if you have only one image per frame, the 
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ALL buttons will not be active). The crosshair icon  centers the current target in the 
middle of the current image frame. 

 
Figure 47: The zoom and centering icons will appear on the left of the Leopard window whenever 
images are displayed. 
 
In addition, a number of overlay options are now available from this tool bar.  This icon 

 will overlay the current fixed target position on an image.  This icon  will draw a 
coordinate grid on the image.  This icon  will extract a slice of flux between two 
points on the image. This icon  will compute statistics in either a circular or 
rectangular area on the image.  This icon  will crop the image.  This icon  will 
allow you to determine the distance between two points on an image.  You can add marks 
on an image and create your own catalog by clicking on this icon .  Finally, this icon 

 provides you with a pulldown menu from which you can select other images to 
overlay on the current image. 

8.2 Archive Query Results Window 
The list of AORs queried from the Archive loaded into Leopard is shown on the main 
window (Figure 48) in the Archive Query Results window.  For each AOR, it lists in 
columns: 
 
• Unique AOR Label 
• Target Name, as entered by the observer 
• Target Position 
• Database Request Key (AOR ID) 
• Retrievable Wavelengths 
• Status of the AOR within the Archive 
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• Version of the pipeline used to process the data 
• Observing Mode (Instrument used in the AOR)  
• Date released into the Archive 
• Date scheduled for observations 
• Preview image of the data  
 

 
Figure 48: The main screen shows the Archive Query Results window, displaying AORs queried 
from the Archive. 
 
Tables formatted in the JAVA language have several features that can be exploited while 
using Leopard.  The columns can be rearranged by clicking on and dragging the column 
headers.  Simply clicking on a column header enables sorting of the table by the column 
contents.  When the header is clicked upon, red or blue arrows appear next to the column 
header.  The red arrow  signifies sorting in increasing order, and the blue arrow  
indicates sorting in decreasing order.  No arrow means that the list is returned to its 
original order.  Click on the column header to do the sorting. You may delete an AOR by 
selecting it and clicking on the Delete Current AOR button.  By clicking and dragging on 
the edge of the header cell, you can change the width of the column. 
 
The small icon  in the upper right hand corner (yellow button  in the upper left hand 
corner for Macs) will iconify the Archive Query Results window and leave the Leopard 
screen clear.  The slightly larger icon  in the upper right hand corner (green button  
in the upper left hand corner for Macs) will minimize and  maximize the area of the 
Leopard screen covered by the Archive Query Results window.  The icon  in the upper 
right corner of the AORs table in the Archive Query Results window allows you to 
control which columns appear in the window.  An example is shown in Figure 49.  When 
you click on the icon, the menu of available columns appears toward the right side of the 
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window.  Simply toggle on or off any of the columns by clicking next to the column 
name.  In the example in the figure, we have turned off the Status and Schedule Date 
columns.  To restore all columns to be displayed in the window, click on the Reset table 
to Factory settings option. 
 

 
Figure 49: An example showing a “custom” display of columns turned off or on, using the columns 
control feature toward the upper right corner of the AORs table. 
 
The Version column indicates which version of the processing pipeline has been used for 
the data.  In the Preview column, for image data (from IRAC, MIPS, and IRS Peak-up 
Imaging), you will see icons in that column that resemble those shown in Figure 50.  The 
icons represent the wavelength at which the image data were obtained.  The Previews are 
lossy-compressed renditions of the post-BCD image mosaics, if available.  They are 
intended only for “quick-look” purposes.  Previews are now available for IRS Staring or 
Spectral Map AORs.  An example of a preview is shown in Figure 51.  For image 
previews image layer control will also appear, to allow you to change the preview image 
contrast, etc.  See section 9.1 for a detailed discussion of image manipulation. 
 
 

 
Figure 50: An example of the preview icons that may appear in the Preview column of the AORs 
table for spectral data.  In this case, the AOR included IRS Staring in several modules.  Click on the 
button to bring up a “quick-look” preview of the data in the dialog window shown in Figure 51. 
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Figure 51:  An example “quick-look” preview of IRS Staring data in all four modules.   

8.3 Main Functions 

8.3.1 Spitzer Archive Query 
Querying the Spitzer Archive for data for specific targets or specific observing programs 
can be accomplished from the Query menu pulldown.  Selecting, for example, a query By 
Position will open the Query dialog box.  Figure 52 shows an example entry in the Target 
Section of the dialog for a cone search. Figure 53 shows an example list of programs 
resulting from the query.  To choose individual programs from the list, click “Selected” 
next to the Program ID number and then click “OK.”  To select all of the programs in the 
list, click “Select All.” Figure 54 shows an example entry in the Program Section of the 
dialog when querying By Program.  For both types of queries, you can select all, some, or 
none of the specific bands, modes, or modules of the three Spitzer instruments.  You can 
also query By Campaign and/or Observer  (see section 7.2.4). 

8.3.2 AOR ID Query 
You can query the Spitzer Data Archive by specific database AOR request key values, 
when known.  The Query -> By AOR ID menu pulldown or clicking on the By AOR ID 
shortcut icon will result in a dialog shown in Figure 55, for entering a single request key 
value. 
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Figure 52: The Query Archive dialog, showing a specific target entered into the Target Section of the 
box. 
 
 

 
Figure 53: An example list of all programs with AORs within the search radius around the target 
position (see Figure 52).  To select individual programs in the list, click “Selected” next to the 
program ID number and then click “OK” (or hit return).  To select all of the programs in the list, 
click “Select All” toward the top of the window. 
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Figure 54: The Query Archive dialog, showing a specific program name or ID entered into the 
Program Section of the box. 

 

 
Figure 55: The AOR ID Query dialog box.  A specific AOR request key can be entered, and the 
results of the query are returned to the main Leopard window. 

 

 
Figure 56: The FLS/Legacy Program Data Products Query dialog. 
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8.3.3 FLS and Legacy Program Data Products Query 
Querying the Spitzer Archive for the various special Archive Data Products, specifically 
from the FLS and the Legacy Science Programs, can be accomplished either from the 
Query -> FLS and Legacy Programs menu pulldown or by pressing the FLS/Legacy 
Programs Query shortcut icon.  Figure 56 shows the dialog.  You can obtain the 
observational data corresponding to the list of AORs. 
 

 
Figure 57: The AOR ID List Query dialog box.  An ASCII file containing a sequential list of AOR 
IDs can be specified from a directory on local disk, and the results of the list query are returned to 
the main Leopard window. 

8.3.4 AOR ID List Query 
The Query -> AOR ID List Query menu pulldown or clicking on the By AOR ID List 
shortcut icon will result in a dialog (Figure 57), showing your local disk directories, from 
which you can select from your local directory a user-provided ASCII file, or simply 
enter the file name, which lists each request key one per line (see section 7.2.6).  This file 
is then uploaded via Leopard to the SSC, where the results of the query are listed in the 
main Leopard window. 

8.3.5 Fixed and Moving Target List Queries 
The Query->By List of Positions menu pulldown or clicking on the By List of Positions 
shortcut icon will result in a dialog (Figure 58), showing your local disk directories, in 
which you can select from your local directory a user-provided ASCII file, or simply 
enter the file name, which lists names or positions of specific targets one per line (see 
section 7.2.7).  This file is then uploaded via Leopard to the SSC, where the query results 
in a list of programs, analogous to Figure 53.  Similarly, the Query->By List of NAIF IDs 
menu pulldown or clicking on the By List of NAIF IDs shortcut icon will result in a 
dialog (Figure 59), showing your local disk directories, in which you can select from your 
local directory a user-provided ASCII file, or simply enter the file name, which lists 
names or NAIF IDs of specific targets one per line.  This file is then uploaded via 
Leopard to the SSC, where the query results in a list of programs, again analogous to 
Figure 53. If, for any of the targets, no programs are found with AORs within the search 
radius, Leopard will show you an error window that looks like Figure 60.  In the error 
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window Leopard tells you the line number of the target search or searches that failed to 
match up with an existing program or programs. 
 

 
Figure 58: The Query by List of Positions dialog box.  An ASCII file containing a sequential list of 
target positions can be specified from a directory on local disk (see section 7.2.7), and the results of 
the list query are returned to the main Leopard window. 
 

 
Figure 59: The Query by List of NAIF IDs dialog box.  An ASCII file containing a sequential list of 
target NAIF names or NAIF IDs can be specified from a directory on local disk, and the results of the 
list query are returned to the main Leopard window. 

 

 
Figure 60: The Query by List of Positions or Query by List of NAIF IDs will return an error window 
like this if no programs are found within the search radius of a target, or with the NAIF name or ID.  
The window lists the line number of the target with no match. 
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8.3.6 Popular Products Query 
Querying the Spitzer Archive for general Popular Products, i.e., the Legacy Science 
enhanced data products, can be accomplished either from the Query -> Popular Products 
menu pulldown or by pressing the Query Popular Products shortcut icon. Figure 61 
shows the dialog that allows you to select the various available data products.  The 
available selections shown in this dialog will be constantly updated as the data are posted 
by the SSC. 
 

 
Figure 61: The Popular Products Query dialog, as of the Leopard v9 release date.  The contents of 
this query dialog are constantly being updated. 

8.3.7 Legacy Ancillary Data Archive Query 
Querying the Spitzer Archive for the Ancillary Data Products from the original Legacy 
Science Programs can be accomplished either from the Query -> Query Legacy Ancillary 
Data Archive menu pulldown or by pressing the Query for Ancillary Data shortcut icon.  
These Ancillary Data Products are served through the NASA/IPAC Infrared Science 
Archive (IRSA; see http://irsa.ipac.caltech.edu). Figure 62 shows the dialog, in this 
example we wish to obtain a 1° radius circular section of the Spitzer First Look Survey 
(FLS) ancillary VLA data (see more details at the FLS page, 
http://ssc.spitzer.caltech.edu/fls/; the coordinates of the center of the section are shown in 
the dialog).  After clicking ‘OK’ in the dialog, Figure 63 shows the results of the query in 
the Leopard main window. 
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In the list of the query results shown in Figure 63, to the far left you can click the “Get” 
box and to the far right is the “Retrieve Now’’ column, where you can select “Click to 
Show Catalog.”  Figure 64 shows the results of obtaining the catalog data.  From this 
dialog you can then save this data table to disk (by clicking on “Save Table”), or as 
shown in Figure 65, display the ancillary data on an image, in this case the IRIS 25 µm 
image showing the FLS field. 
 

 
Figure 62: The Spitzer Legacy Ancillary Data Archive Query dialog. 
 

 
Figure 63: The main Leopard window, showing the results of the example in Figure 62, the selection 
of the Spitzer First Look Survey ancillary VLA data. 
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Figure 64: The dialog, listing the results of the example in Figure 62, the selection of the Spitzer First 
Look Survey ancillary VLA catalog data.  See section 15.4 of the Spot User’s Guide for detailed 
discussion of the format of the dialog box. 
 

 
Figure 65: The main Leopard window, showing the example ancillary data listed in Figure 64 
overlaid on the IRIS 25 µm image containing the FLS field.  To the far right of the displayed ISSA 
image are two layer control boxes. 
 
In Figure 65, you can see two boxes to the far right of the displayed image, shown in 
Figure 66.  These are layer control boxes, one of which controls the base image (the 
displayed ISSA image), and one that can allow you to constrain the range of parameters 
for the data overlaid on the image.  See section 9 for a more detailed discussion of image 
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overlays and layer controls.  Figure 67 shows the dialog that pops up when you click the 
far right icon  in this layer control box.  In this example the dialog shows controls that 
would allow the user to set the minimum and maximum source counter number, ‘cntr,’ 
for the ancillary VLA radio data. 
 

 
Figure 66: The two layer control boxes, one controlling the base image and the other, labeled ‘I,’ 
controlling the image overlay window. 
 

 
Figure 67: Within the layer control box labeled ‘I’ shown in Figure 66, clicking the icon to the far 
right will bring up the dialog shown here, which allows the user to constrain the various parameters 
of the ancillary data.  In this example, the range of the data counter number, ‘cntr,’ can be adjusted 
in the dialog box. 

8.3.8 Login to Spitzer Archive 
You can login to the Spitzer Data Archive either from the File -> Login to Spitzer 
Archive menu pulldown or by clicking on the Spitzer Archive Login shortcut icon.  This 
login is required for obtaining proprietary data.  Non-proprietary data do not require a 
login.  Figure 68 shows the dialog for entering your user name and password to obtain 
your data.  The user name and password are issued to you by the SSC for your specific 
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Spitzer program data.  (Note:  These are not the same as your proposal username and 
password.)  You will be notified by the SSC when your proprietary data are in the 
Archive.  To logout of the archive, use the File -> Logout from Spitzer Archive menu 
pulldown.  Additionally, you can change your password using the File -> Change 
Password to Spitzer Archive menu pulldown. 
 

 
Figure 68: The Spitzer Archive Login dialog.  The SSC provides you with the user name and 
password for your proprietary data.  The user name shown here is purely illustrative. 

8.3.9 Detail Information 
You can obtain detailed information about the AOR or ancillary data (see section 8.3.7 
and Figure 63) that you have highlighted by clicking on the AOR or ancillary data entry 
in the main Leopard window.  This can be accomplished from the Info -> Detail 
Information menu pulldown or by clicking on the Detail Information shortcut icon.  
Figure 69 shows the detail information dialog, in this case for the FLS AOR.  Clicking on 
the tabs toward the top of the dialog box will provide different types of information about 
the AOR or ancillary data, including the AOR parameters, the size (in bytes) of the 
available data, the program information (specifically, the program PI information and 
abstract), comments about the data quality by the SSC Data Quality Analysis (DQA) 
team, and a preview visualization of the basic calibrated data (BCDs). 
 
You can roughly estimate what the total integration time is for an AOR from the 
“Params” tab, by looking at the “frame time,” “number of frames,” “number of cycles,” 
etc., but to far more precisely estimate the total integration time per pointing, you should 
use this information in conjunction with that from the Depth of Coverage image overlay 
(see section 7.7.21). 
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Figure 69: The Detail Information dialog.  Clicking on the tabs toward the top of the box provides 
various types of information about the AOR or ancillary data. 
 

 
Figure 70: The List of Targets dialog. 
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Figure 71: The Target dialog, in this case, for a fixed single target. 
 
 

 
Figure 72: The visibility window/orientation dialog, in this case, for a fixed single target. 
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8.3.10 List of Targets 
This feature is analogous to the target list feature in Spot. When AORs are listed in the 
Archive Query Results window, clicking on the Target List icon ( ), or, alternatively, 
using the Info -> Target List menu pulldown, will result in the list of targets 
corresponding to those AORs (Figure 70).   Targets in the list can be deleted individually 
by highlighting them one at a time and then clicking the Delete button.  You can also 
delete all targets in the list using the Edit -> Delete All Targets pulldown. Click on the 
Modify button to bring up the target dialog shown in Figure 71.  To obtain visibility 
window and orientation information on the target, press the Visibility/Orientation button 
in this dialog (see the Spot User’s Guide, section 10.7 for a more detailed discussion on 
target visibility windows).  The visibility window/orientation dialog, shown in Figure 72, 
will list a target’s visibility windows and, for a given date (typically, the date the AOR 
was executed), will calculate the position angles for the various FOV when you press the 
Calculate Position Angle button.  To estimate the sky background for the target, press the 
Background button in the target dialog (Figure 71), and the dialog shown in Figure 73 
will appear.  You can then calculate the background, by pressing the Do Estimate button, 
for any wavelength (in µm) and for either a specific date or over the range of dates that 
the target is visible to Spitzer (see the Spot User’s Guide, section 10.7).  Once the 
visibility windows/orientation and/or background have been estimated, you can list these 
values by pressing the Show Visibility or Show Background buttons in the List of Targets 
dialog in Figure 70. 
 

 
Figure 73: The background dialog, in this case, for a fixed single target. 

8.4 Bottom Bar  
At the bottom of the main screen (Figure 48), Leopard provides information about the 
currently selected AOR dataset(s), as well as information about the status of the network 
and the total number of AORs in the window (Figure 74). The information provided 
includes: 
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• The number and size, in bytes, of selected data products for download to local 
disk. 

• Queue/download status of data requested from the Archive. 
- Partially queued:  You have requested a part of a data product, and it has been 
queued for download.  Note that you do not have to request all the available data for 
this product.  For example, you may have requested only the raw data, but not the 
BCD data. 
- Fully queued:  All data available for this product have been queued for download. 

- Partially downloaded:  You have requested part of a product, and it has been 
downloaded to local disk.  Note that you do not have to request all the available data 
for this product.  For example, you may have requested only the raw data, but not the 
BCD data. 

- Fully downloaded:  All data for this product have been downloaded to local disk. 
• Data product type options (Raw, BCD, Post-BCD, Calibration) to download.  

• Disk Icon - If you have selected data to download from the Archive, the diskette icon 
will appear in the bottom bar of the main window. You may begin the download 
process by clicking this icon, clicking the disk icon in the upper icon bar, or selecting 
the File -> Download Selections pulldown menu.  

• Net Icon - The Net Up or Net Down words and symbols give you the current status 
of your connection to the servers at the Spitzer Science Center, if you are connected 
via the Internet. If the network is down, or you are working offline, you can still enter 
target information into Leopard and display images or catalogs you have cached or 
have locally on disk. You cannot query the Spitzer Archive, obtain target background 
estimates, visibility windows, orientation information, or load new images or catalogs 
from the server if the network is down.  

• Total AORs/Total Products – If you queried AORs from the Archive, on the far 
right of the bottom bar, Leopard reports how many AORs are currently loaded, and 
how many possible data products (wavelengths) are possible to download.  

 

 
Figure 74: The bottom of the main Leopard window, showing the results of an Archive query.



Leopard User’s Guide v9 
 

June 18, 2008 68 

 

9 Target and AOR Visualization 
In this section, we describe the Leopard capabilities for visualizing the sky at target 
positions.  Overlaying the area coverage of an AOR is discussed in section 7.7.17. 
Descriptions of the Images and Overlays menu functions are discussed in sections 7.6 and 
7.7. In this section, we walk through examples using Leopard’s visualization capabilities 
in assessing AORs. 

9.1 Displaying and Manipulating Images  
To visualize the sky at a target position, you can go directly to the Images menu and 
select the appropriate sky image(s).  In sections 7.6.1 and 7.6.4, we showed how to 
download IRAS images and Digital Sky Survey (DSS) images. In Figure 75 we show 
what the Leopard screen would look like after downloading an IRIS 25 µm image and a 
DSS Second Generation image. The frame with the DSS image is the currently active 
frame. If you display multiple images within a frame, the tabs along the bottom of the 
frame allow you to toggle between the images in the frame. 

9.1.1 Image Control 
To zoom the image in or out, use the magnifying glass icons on the left of the Leopard 
window (Figure 75; see also Figure 47).  The  icon will zoom in the current image, 
and the  icon will zoom out.  The  and  icons will apply the zoom to all the 
images in the selected frame. To move the image around in the frame you can use the 
scroll bars on the frame or move the positioning box on the thumbnail image. 

9.1.2 Image Window Control 
When using the visualization tools, we suggest that you maximize your Leopard window 
to fill your computer screen.  The displayed image space can then be maximized by 
clicking the maximize icon  in the upper right hand corner of the image frame.  
However, if you need to place more than one image in the Leopard window, you can 
minimize the image by clicking the minimize icon .  (The Mac equivalent is the green 
button  in the upper left hand corner.)  The iconify icon  will place the image icon at 
the bottom of the Leopard window (the Mac equivalent is the yellow button  in the 
upper left hand corner). To delete the image window, click on the delete icon  in the 
upper right hand corner (the Mac equivalent is the red button  in the upper left hand 
corner). 

9.1.3 Cursor Readout 
When you move your cursor over an image the flux, pixel scale, and two sets of 
coordinate values are displayed below the Leopard icon bar.  See section 7.8.5 to select 
which coordinate values Leopard returns in these displays.  For ISSA/IRIS images, 
Leopard returns flux values in MJy/Sr in the left-most readout below the icon bar.  
For 2MASS images, you should not rely on the DN readout for photometry.  Use the 
2MASS catalogs for accurate photometric measurements. 
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Figure 75: The Leopard screen after downloading ISSA 25 µm and DSS Second Generation images. 

9.1.4 Layer Control 
The side bar to the right of the image frames (Figure 75) shows a box that says “Base 
Image” with show/hide layer , delete layer , opacity control , color table control  
and image header  icons in it.  If you click the show/hide layer icon, Leopard hides or 
shows the image.  If you click the delete layer icon, the image layer in the frames will be 
deleted. The opacity control icon brings up an image opacity control dialog. This allows 
you to control how opaque will be the image layer. This is very useful if you have a 
second image as an overlay in a frame (not ‘loaded’ in the same frame, overlaid as in 
Overlay -> Image Overlays from the Leopard menus). The color table control icon brings 
up a dialog allowing you to adjust the color table for the image.  
 
The side bar contains the controls of image and overlay layers.  You can create several 
layers and then hide or show them with the show/hide layer icons without having to 
recreate them each time.  Each overlay introduces a new layer control box on the side bar. 
The Base Image layer does not need to be the bottom layer. You can move it between 
other overlays in the frame by clicking on any part of the layer control box and dragging 
it between layers to where you want it. 

9.1.5 Three-Color Image Display 
Leopard provides you with the ability to produce three-color composite image display for 
overlays.  The three images are read individually into the ‘red,’ ‘green,’ and ‘blue’ (RGB) 
color planes to produce the composite. To produce a composite, first select an image 
from the Images menu.  Then, select “Make This a 3 Color Plot” in the Three Color Plots 
box in the Image window (see, e.g., Figure 21).  Choose the color plane into which you 
wish to read the image.  In Figure 76 we illustrate this with a generic FITS file, in this 
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case, a Spitzer image of M51 from the SINGS Legacy program.  The IRAC Channel 1 
(3.6 µm) image is read into the blue color band. 
 

 
Figure 76: A single FITS image (in this case, the Spitzer SINGS Legacy project 3.6 µm image of 
M51) mapped into the blue color band.  Note at right of the image the layer control box allowing you 
to add other images into the remaining color bands. 

 
Figure 77:  The menu of images that can be added into the next color plane.  The image mapped into 
the additional color band does not necessarily need to be of the same type.  Any of the images listed 
can be selected. 
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Figure 78:  The full three-color composite image display of the M51 Spitzer IRAC data. 

 

Figure 79: A three-color composite image display for M51 – the DSS image is mapped into blue, the 
2MASS Ks image is mapped into green, and the Spitzer IRAC 8.0 µm image into red. 
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To read in another image and map it into another color plane, for instance, green, select 
the “Add Color: green” item in the layer control box shown in Figure 76 for the base 
image.  This results in a menu from which you can select the next image in the composite 
(Figure 77).  In this case, we will select the Channel 2 (4.5 µm) Spitzer image of M51 to 
map into green.  Finally, we will select the Channel 4 (8.0 µm) image to map into the red.  
The resulting three-color composite is shown in Figure 78. The three images do not 
necessarily need to be from the same image source.  You also do not need to use all three 
color planes.  For instance, the composite shown in Figure 79 is assembled from the DSS 
image of M51 mapped into the blue band, the 2MASS Ks image mapped into green, and 
the IRAC 8.0 µm image mapped into red.  Note that Leopard will automatically perform 
any transformations for the images, so that they are registered to a common reference 
frame, using the WCS information in each of the image headers.  You can use the layer 
controls for each image to show/hide the layer, delete the layer, or adjust the color table 
for the layer. 

9.1.6 Cropping Images 
The Crop utility under the Overlays menu (and also along the image manipulation and 
overlays tool bar) allows you to crop an image in the Images window.  As illustrated in 
Figure 80, once the utility is selected, simply drag your cursor across the image, while 
holding the left mouse button, and a red box will be drawn, delineating the image section 
you wish to crop.  Releasing the mouse button will result in a cropped copy of the 
original image, as shown in Figure 81, with the original image left intact. 

 

Figure 80: Once the Crop utility under the Overlays menu (also the Crop icon in the image 
manipulation and overlays tool bar, along the left side) has been selected, drag the cursor across the 
image, while holding the left mouse button, as shown in the figure. 
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Figure 81: Using the Crop utility, a cropped copy of the original image is created, after selecting the 
image section to be cropped (see Figure 80). The Use Large Control Icons option has been set in this 
example. 

 
Figure 82: Once the Area Statistics utility under the Overlays menu (also the Area Statistics icon in 
the image manipulation and overlays tool bar, along the left side) has been selected, drag the cursor 
across the image, while holding the left mouse button, as shown in the figure.  This will result in an 
aperture being drawn on the image.  Releasing the mouse button will open the results dialog shown 
in Figure 83.  A red “X” appears on the image when one of the quantities in the dialog is highlighted. 
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9.1.7 Measuring Area Statistics 
The Area Statistics utility under the Overlays menu (and also along the image 
manipulation and overlays tool bar) allows you to draw either a circular or rectangular 
aperture on an image in the Images window.  As illustrated in Figure 82, once the utility 
is selected, simply drag your cursor across the image, while holding the left mouse 
button, and a red aperture will be drawn, delineating the image section you wish to define 
as the area over which the statistics will be computed.  Releasing the mouse button will 
result in a dialog window, as shown in Figure 83.  The quantities that are computed 
within the defined area are the mean flux (and the standard deviation from that mean), the 
integrated flux, the maximum and minimum fluxes, and the aperture and flux-weighted 
centroids.  Moving the mouse over any of the latter four quantities in the dialog will 
result in a red “X” showing the position for that quantity on the image.  The pulldown 
menu within the dialog allows you to select either a circle or rectangle to define the 
aperture. 

 
Figure 83: Using the Area Statistics utility, the dialog window in the figure opens, showing the 
resulting statistics within the aperture drawn in Figure 82.  The pulldown menu toward the top of the 
window allows you to select either a circular or rectangular aperture. 

9.2 Current Fixed Target Overlay 
To see the position of your target on the current image, select Current Fixed Target from 
the Overlays menu (section 7.7.7). Leopard will display a red box at the coordinate 
position of the target you currently have selected from the target list.  The current target 
is always listed in the Leopard bottom bar.  In Figure 84 we show the current target for 
the FLS field marked on the ISSA 25 µm and DSS images. Another layer control has 
now been added to the side bars.  You can show or hide the Target box with the 
show/hide layer icon and delete this overlay with the delete layer icon. 
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Figure 84: The current target position is marked on the IRIS 25 µm and DSS images by the red box. 
 

 
Figure 85: The left frame shows an equatorial J2000 (degrees) coordinate grid overlaid on the IRIS 
25 µm image. The right frame shows the 2MASS Point Source catalog overlaid on the DSS image. 

9.3 Overlaying a Coordinate Grid 
The result from selecting Grid from the Overlays menu (section 7.7.5) and choosing an 
equatorial J2000 coordinate grid for the IRIS 25 µm image is shown on the left in Figure 
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85.  The additional layer control labeled ‘Grid’ has also appeared in the side bar.  In 
addition to the show/hide layer and delete layer icons, there is now a coordinate grid 
control icon .  Clicking on this brings up a dialog where you can change the type of 
coordinate grid shown in the overlay. 

9.4 Overlaying a Catalog 
In Figure 25 we show the dialog that allows selection of the (IPAC) catalog overlays.  
The results of the selection in the figure (2MASS Point Source catalog with a 2.5° search 
radius) are shown in the right image (DSS) displayed in Figure 85.  The layer control for 
the catalog has the name of the catalog, 2MASS PSC.  There are four boxes in the layer 
control that allow you to do various things: The usual hide/show and delete layer icons 
are now joined by a catalog table  icon and constrain data  icon.  
 

 
Figure 86: The table of the data in the catalog overlay shown on the right in Figure 85.  You can 
manipulate which objects are marked and how they look from this dialog. 
 
Click on the catalog table icon and a list, such as that seen in Figure 86, will appear.  
Each object in the catalog found within your specified search radius is listed. As with 
other target lists you can sort the columns by clicking on the column headers (once for 
sorting up, twice for down, and a third click will return you to the original order of the 
catalog). The color and shape scheme for the catalog overlay allow a few kinds of 
selecting and highlighting so some explanation is needed. When a catalog is overlaid all 
the objects’ marks in the catalog are ‘On’ (checked in the ‘On’ box) and shown with the 
default red color. Clicking on a line in the catalog will activate that object’s mark as 
‘selected’. The color of that object’s mark will change to yellow -- the ‘selected’ color. 
Clicking on another line in the catalog will turn the color of that object’s mark to yellow 
and the first object’s mark will change color back to what it was previously.  
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You can highlight certain objects in the catalog by clicking on the ‘Hi’ box for the object. 
At first the object’s mark will turn yellow (the ‘selected’ color since you clicked on it). 
When you click on another object in the catalog, the first object’s mark will turn blue, the 
highlight color. Both the selected and highlighted colors of object’s marks appear when 
the object is On (‘On’ box is checked). If you ‘Hide All’ or otherwise turn off various 
objects in your catalog, selecting or highlighting them will not turn the marks back on 
with the appropriate color. They must be ‘On’ for selecting or highlighting to work. The 
Color box at the top of the Catalog Window controls the color of the object’s marks when 
they are On (‘On’ box is checked). It does not change the color of selected or highlighted 
marks. This will be the color of object’s marks when the objects are ‘On’ but not 
otherwise highlighted or selected. 
 

 
Figure 87: This dialog allows you to select the ranges of the data in the table currently displayed in 
the overlay.  This example selects K band sources with magnitudes between about 11 and 16. 
 
The constrain data icon will bring up a dialog with sliders, which allow you to easily 
select the range of data to display, or to exclude, for your table for a given data field.  An 
example is shown in Figure 87 that selects Ks-band magnitudes between about 11 and 16. 

9.5 Overlaying an Image 

It is possible to overlay one image onto another by selecting Image Overlays in the 
Overlays pulldown menu.  Once you have selected your base image from the Images 
pulldown menu, the Image Overlays menu allows you to select another image (either 
ISSA, 2MASS, MSX, DSS, SkyView, NED, or a user-selected FITS image from local 
disk) to overlay on the base image.  The opacity of each image can be controlled using 
the opacity control dialog that pops up when you press the  icon in the layer control 
box for each image.  In Figure 88 we show an example of a Spitzer IRAC image overlaid 
on a DSS image. In this example, the opacity of the top layer has been adjusted to 25%, 
and the bottom layer, 90%. You can vary an image’s opacity by adjusting the slider on 
the control.  You can continue to overlay additional images, if desired.  Also, you can 
perform these image overlays in color (red, green, or blue), by selecting “Make This a 3-
Color Plot” when overlaying an image.  The three-color image visualization described in 
section 9.1.5 is analogous to this utility. 
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Figure 88: An example of Image Overlays.  Here we have overlaid a Spitzer IRAC image on a DSS 
image of a famous Messier object.  The opacity of each image can be adjusted using the opacity 
control.  In this example, the opacity of the top layer has been adjusted to 25%, and the bottom layer, 
90%. 
 

 
Figure 89: Once the Slice Tool under the Overlays menu (also the Slice Tool icon in the image 
manipulation and overlays tool bar, along the left side) has been selected, drag the cursor across the 
image, while holding the left mouse button, to produce the image slice. 
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9.6 Using the Slice Tool 
You can extract a “slice” of an image, i.e., the radial distribution of flux as a function of 
position on the image.  After selecting the Slice Tool utility under the Overlays menu 
(also available on the image manipulation and overlays tool bar along the left hand side), 
drag the cursor along an image, as shown in Figure 89.  The slice tool dialog window will 
pop up (Figure 90) as a result.  Moving the red “X” with your cursor along the slice in the 
Images window will show you the position along the slice in the slice tool dialog 
window.  Moving your cursor in the slice tool dialog window along the slice, from point 
to point, will show you the position along the slice on the image.  Letting the cursor 
linger on any data point in the dialog window will show you the flux value, and position, 
at that point.  Also shown in the dialog window is the total spatial distance of the slice, in 
the distance units you select.  Holding the right mouse button will bring up a menu of 
options:  You can set the properties of the slice, save the slice image to local disk, zoom 
in and out along the slice, and set the range of parameters for the slice. You can also save 
the slice data (the table of flux versus position) to local disk by clicking on the “Save 
Data” button in the window. 
 

 
Figure 90: Once you have traced out your image slice, the Slice Tool dialog window will open, 
showing the slice.  Holding the cursor over any of the points shows the position and flux for that 
point.  Holding down the right mouse button brings up a menu of options for zooming in or out on 
the plot, as well as saving it to local disk.  A slice of each overlaid image in Figure 88 is shown. 
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9.7 Overlaying AORs 
Descriptions of how to overlay the Spitzer focal plane and AORs were given in sections 
7.7.14 and 7.7.17. We now provide some examples that explain in more detail how to use 
the AOR visualization features.  Overlaying the area footprint of an AOR will be 
particularly useful to assess the quality and success of the execution of the AOR, 
specifically about the AOR covering or avoiding particular features on the sky and how 
the AOR was oriented on the sky on the observation date (or any other date).  A more 
complete set of overlay examples can be found in the Spot User’s Guide, section 15.7. 

9.7.1 Features of AOTs when Overlaying an AOR 
There are features of the detector arrays, apertures, or distortions that may appear when 
you visualize AORs. Here is a brief summary by instrument: 

9.7.1.1 Features in IRAC Visualizations  
The boxes depicted in each overlay are an average of each FOV for the IRAC instrument.  
Because there are two detectors per FOV, there are slight offsets for each detector 
relative to the average FOV. See the Spitzer Observer’s Manual for details on the true 
positions of each detector. Observers should use these visualizations with care. 
 
The ‘crescents’ and ‘rhomboids’ are X-filled boxes displayed beside each aperture. 
Scattered light will fall onto the detector if a bright source happened to fall within these 
tiny regions. If you are planning to analyze data for a target that has nearby bright 
objects, you will want to assess whether these bright objects fell into these small regions. 
See the IRAC Data Handbook for more details. 

9.7.1.2 Features in IRS Visualizations  
The IRS peak-up observations (the IRS peak-up array aperture) are included in the 
overlay, if peak-up is selected in the AOR. Once the peak-up is performed, the peak-up 
arrays continue to appear in the AOR visualization as rectangles with an X in them. The 
peak-up is not shown if a peak-up was not selected. The PCRS peak-up is not visualized 
if it was selected. Note that peak-ups are only performed on the peak-up target, not on 
each target within a cluster target type. 
 
IRS Staring observations perform 2 ‘dithers’ per aperture, going from 1/3 of the way in 
the slit to 2/3 of the length of the slit. These dithers appear in the visualizations 

9.7.1.3 Features in MIPS Visualizations  
The 70 µm array as viewed on the sky represents the missing side B.  Missing sections 
from the 70 and 160 µm arrays are also represented. 
 
The dither positions for MIPS Photometry/Super-resolution were optimized for 
performance after launch. A description of all available dithers can be found in the MIPS 
chapter of the Spitzer Observer’s Manual. 
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MIPS SED mode performs two dithers in the slit, similar to the IRS Staring mode. The 
MIPS Total Power mode visualization resembles the Photometry/Super-resolution mode 
(additionally, the option exists to show or hide parallel data obtained in this mode). 
 
Using the images in the figures from the above sections, we provide several examples of 
overlaying an AOR here. 
 

 
Figure 91: The overlay of an IRAC Mapping AOR on a 12 µm ISSA image and a DSS image. 

9.7.2 Overlaying a Single AOR 
As an example of overlaying an AOR, we show a IRAC mapping AOR, which uses full 
array mode, both FOVs turned on, a 7×4 map with a 5-position Gaussian small-offset 
dither, and a 12-second frame time. 
 
After selecting the AOR and displaying the images, we select the AORs on Current 
Image option from the Overlays menu. Because this AOR has already been scheduled 
(and executed), the overlay for the AOR will be for that scheduled date. The area 
coverage for the AOR is now displayed in Figure 91. The area covered by the AOR is 
shown on both the 5° ISSA image and the 0.5° DSS image.  Clearly, for large maps, you 
can only really see what the sky coverage is in the larger image.  Note that for an AOR 
that has not yet been scheduled, a visibility window dialog, similar to what is shown in 
Figure 72, appears.  You can enter the default observation date (the mid-date within the 
visibility window), however, any date within a visibility window can be entered. 
 
Layer controls for the AOR overlays appear in the side bars of the displayed images.  
These are indicated with the AOR label.  The pointings table icon  in the layer control 
allows you to modify how the AOR overlay is displayed.  If you click on it, the resulting 
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dialog is shown in Figure 92. Each box drawn in the overlay has a corresponding line in 
this table.  The FOV selected here in each case is the IRAC position, between the two 
arrays, which is the FOV for mapping in full array mode with both FOV selected.  These 
can be individually turned on and off with the checkboxes, or you can use the animation 
buttons to see how the overlay is created, one box at a time.  The ‘Animation’ button will 
cycle through each IRAC FOV box in the overlay.  The ‘Animation w/Trail’ button will 
perform the same task, but will “freeze” each FOV on the image as the animation 
progresses.  You see the full overlay built up one exposure at a time. The focal plane 
configuration icon  will bring up a small dialog window, in which you can choose to 
turn off one or more of the aperture FOV in the displayed AOR. 
 

 
Figure 92: IRAC Overlay pointings table for the AOR described below and displayed in Figure 91. 
 

 
Figure 93: The dialog for saving to a file on local disk the information from the pointings table for 
the AOR overlay shown in Figure 92.  This file can later be read back into Leopard, using Read AOR 
Overlay Mapping File option in the Overlays pull-down menu. 
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You can save to local disk the contents of the pointings table.  Clicking on the Save 
button in the pointings table results in the dialog shown in Figure 93.  Here, a file name 
and directory on local disk can be specified, before saving the “.pts” file.  This file can 
later be read back into Leopard, as described in section 7.7.18.  Currently, each overlaid 
AOR must be saved one at a time to separate files. 
 
You can change the date for the overlay by pressing the replot  icon, which again 
brings up a target visibility window dialog (see Figure 72).  Simply enter a new date and 
time for the overlay, and the AOR overlay will likely change, due to any different roll 
angle of the spacecraft for the new date.  The overlay will then look like Figure 94. 
 

 
Figure 94: IRAC overlay of an IRAC Mapping AOR on a 12 µm ISSA image and a DSS image.  The 
AOR is shown on the DSS image for a different date than in Figure 91.  

9.7.3 Overlaying Multiple AORs 
You can overlay multiple AORs on an image at one time.  See section 7.7.17 and Figure 
35.  The AORs will be overlaid for their observation dates.  If one or more AORs has not 
yet been scheduled, you will see a dialog, as shown in Figure 95, which asks if the same 
observation date within a visibility window can be applied to each of the unscheduled 
AORs to be overlaid.  If we select to overlay both the example IRAC mapping AOR and 
also a MIPS Scan AOR (a medium scan with 10 scan legs) from the same observing 
program for the same field, the result is what is shown in Figure 96.  Obviously, more 
than one AOR must be listed in the main Leopard Archive Query Results window for this 
utility to apply. 
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Figure 95: The dialog that follows selection of the date for visualization when attempting to overlay 
more than one AOR at a time on an image. 

 

Figure 96: The overlay of both the IRAC Mapping AOR and a MIPS Scan AOR on the IRIS 25 µm 
image and the DSS image on the same date for visualization.   

9.7.4 Displaying Moving Target AORs 
To evaluate completed or pending Spitzer solar system observations, Leopard provides 
the capability to display the position of moving targets on the infrared sky as a function 
of date and time. In addition, the user can also visualize the position of a moving object 
with respect to the Spitzer focal plane, instrument apertures, diffraction spikes, and other 
nearby moving objects. Visualization of a Spitzer AOR for a moving target is supported, 
and shows the positions on the sky of individual data frames within an AOR, taking into 
account both the spacecraft and moving object's motion. Visualization of an AOR in the 
object's rest frame is currently not explicitly supported for moving targets, but can be 
mimicked by selecting a position and its corresponding date from the object’s orbital 
path, and entering this as a fixed target position.  
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These capabilities are provided to allow the user to evaluate moving target observations 
with Spitzer at the executed or available backgrounds/times for observation, and by being 
able to visualize the AOR pattern across the sky and the effect of nearby bright objects on 
the observation.  
 

 
Figure 97: The dialog box for requesting an ISSA image of the sky background for Pluto. 

9.7.4.1 Selecting a Background Sky Image 
For a moving target AOR, select "Images" from the menu bar and select the type of 
image you would like to have used to show the background of the target. Section 7.6 
describes the types of images that can be used, including a user-provided FITS image, 
with some important caveats on their suitability for quantitative background estimates. 
Note that if the observations are of a rapidly moving object, such as a comet or near-
Earth asteroid on close pass to Earth, it may be more instructive to select the All Sky 
Images option (section 7.6.11), at least until you can determine the extent of the object's 
path across the sky. Generally, though, requesting the ISSA/IRIS plates with the default 
parameters is a good starting point for visualization (Figure 97). 

9.7.4.2 Selecting an Observation Date 
Once a type of background image has been selected, you will be asked to enter an 
observation date to allow Leopard to select the correct background image on which to 
display the target (Figure 98).  In the Select Observation Date window that appears, 
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Leopard will display the visibility windows for the object. Enter a date within the 
visibility window periods (or click on any visibility window in the dialog to 
automatically select the window’s mid-date), choose the number of points on the orbital 
track that you would like Leopard to label, and click on OK.  
 

 
Figure 98: Target Visibility dialog for Pluto. The Number of Points allows you to choose the number 
of date points Leopard will display for your moving target. You can then animate through the track 
of the moving target on the displayed image. 

If you are displaying on an ISSA, 2MASS, DSS or NED image, the track of the object 
across that image on the date specified should now be visible in the Leopard window 
(Figure 99).  If you are displaying on an All Sky Image, you will need to go to the 
Overlays menu and select Add Moving Target before the track will be displayed.  

9.7.4.3 Highlighting Points and Displaying Date Markings on a Moving Target Trajectory 
Now you have an infrared image of the sky with the path of your object across it centered 
on the observation date you entered. On the lower right side of the Leopard window, 
notice that there are two groups of small icons (Figure 100), one labeled "Base Image" 
and the other labeled with the target name. The  icon is a toggle that turns each display 
component on and off. The  will delete the component with which it is associated (use 
with caution!). If you do inadvertently delete something you had merely wanted to switch 
off for a moment, you can only recover it by going through the original steps required to 
display that component.    
 
There is a cluster of mini-icons associated with the object name in the side bar. Clicking 
on the catalog table icon  (the rightmost mini-icon in the "Pluto" box shown in Figure 
100) will display a list of dates and positions for the moving target (Figure 101). 
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Figure 99: Displayed track of Pluto on an ISSA plate background. The Number of Points selected 
was 20. 
 
In this display, "Hide All Points" will remove the point markings from the trajectory 
(once "Hide All Points" has been clicked, it will be replaced with "Show All Points" so 
that this button acts as a toggle).    
 
The first column of the table allows you to select which points to display by toggling the 
check mark on or off. The "Hide Path" toggle button will remove the trajectory but leave 
the points, if desired.   The second column, marked "Hi", allows you to selectively 
highlight points (and dates, see below). The current selected point is highlighted in one 
color, and previously highlighted points are given a different color.  The third column 
allows you to change the shape of the plotted points. 
 
The "Show All Dates/Hide All Dates" toggle button will label each of the points on your 
trajectory with the date. A subset of the dates can be displayed by toggling the check 
mark under the "Show Date" column.  The RA/Dec. positions for the selected dates are 
shown in the table. However, RA, Dec., and underlying flux at any point on the image 
(and the trajectory) can be determined by moving the cursor over the image and reading 
the position from the table just under the menu icons in the main Leopard window. 
Clicking on the Line Color or Point Color buttons allows interactive selection from color 
tables for line and point color.  The Save Table button allows the user to save the table 
text (i.e., the date, RA and Dec.) as a plain text file to local disk. 

9.7.4.4 Adding Your Own Marks/Labels to a Trajectory or Image 
If you want to add your own marks to a trajectory or image, select "Mark Object on 
Plot/User created catalog" from the Overlays menu on the Leopard main menu bar.  Then 
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use the left mouse button to add marks to the image or trajectory.  Leopard will record the 
RA and Dec of the positions marked, which can be accessed under the list icon  in the 
"Marks" box now on the right of your image display (Figure 102). Labels for the points 
marked can also be entered (in the User Marks “Name” field) and will be added to the 
image display when the user clicks the "Done" button on the Marks catalog window.  The 
list of marks can be saved to a table on local disk, by clicking the Save Table button and 
specifying a table name and local disk directory in the resulting dialog. 
 

 
Figure 100: Icons associated with each layer drawn in the visualization frame. In this case there is an 
ISSA Image and the track of Pluto is overlaid. Clicking the check mark will 'hide' the layer. Clicking 
the 'X' will delete it. Clicking ‘%’ will allow you to modify the opacity of the displayed image. 
Clicking the color grid will allow you to modify the color table options for the displayed image. 
 

 
Figure 101: List of dates and positions for Pluto. This dialog box will appear if you click on the 
catalog table icon under 'Pluto' in Figure 100. 
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9.7.4.5 The Distance Tool 
This tool can be used at any time during moving target visualization, but is particularly 
useful when you want to determine the approximate angular separation of a moving 
target and a nearby fixed target, or two moving targets on a given date. To activate it, go 
to the Overlays menu on the Leopard main menu bar and select "Distance Tool."  Now 
use the left mouse button to select a point and drag to another point.  A colored line 
should appear, denoting the distance that you dragged the cursor, and the distance in 
arcseconds will be displayed above the line (Figure 103).   
 
Note that estimating the distance between two moving targets using this tool is only valid 
between points on the two trajectories that correspond to the same date. We have exact 
date point matching for two moving bodies in Leopard. With this "hand drawn" tool, it is 
possible to estimate separation distances to an accuracy of a fraction of an arcsecond, 
when compared with the calculated ephemeris positions. However, if you require 
separation estimates to higher accuracy, we strongly recommend that you calculate these 
separations using JPL’s Horizons software.  For instructions on how to use Horizons to 
assist with Spitzer observation planning, please see the instructions provided on the 
Spitzer Science Center web site on the Proposal Kit page. 

9.7.4.6 Displaying the Spitzer Focal Plane 
To display the Spitzer Focal Plane to scale, go to the Overlays menu in the main Leopard 
menu bar and select "Spitzer Focal Plane."  The focal plane to scale will appear on your 
image. Clicking the left mouse button at a position on the image will re-center the focal 
plane at the click point.  Note the cluster of mini icons labeled "Spitzer" that have 
appeared on the right of the image window (Figure 104). The box with the number in it 
shows the position angle of the focal plane. The focal plane is generated at a default 
position angle of 0.0°. To visualize the focal plane on a particular date for AORs that 
have not yet been scheduled, use the Visibility/Orientation capability in the Modify 
function of the Leopard Target List window, after selecting the moving target (see section 
8.3.10).  Determine the position angle for the Spitzer focal plane on the desired date. You 
can then enter that position angle into the box in the "Spitzer" layer control to re-orient 
the focal plane display.   In the example in the figure, a position angle of 35° has been 
entered. 
 
The focal plane configuration icon  in the "Spitzer" layer allows you to toggle 
apertures on and off and change the color of the displayed apertures. See the Spitzer 
Observer's Manual for a full description of the apertures on the focal plane. The arrow 
pointing to the Sun symbol in the focal plane display denotes the Spitzer-Sun direction, 
as projected on the sky. 

9.7.4.7 Displaying the Spitzer Diffraction Spikes 
Once you have the Spitzer focal plane displayed on your image, clicking the rightmost 
small icon under the "Spitzer" layer, the diffraction spike show/hide icon , will display 
the Spitzer diffraction spikes for the position angle entered in the "Spitzer" layer box 
(Figure 105). Again, like the focal plane itself, these diffraction spikes can be 
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repositioned by clicking the left mouse button on the desired center. They can be 
rotationally repositioned only by entering a new position angle.  
 

 
Figure 102: Adding marks to an Image. Another layer called "Marks" is added to the frame. 
Clicking on the list icon under “Marks” will bring up the dialog box of User Marks. 
 

 
Figure 103: The Distance Tool in action. The blue arc indicates the distance between the two selected 
points. The distance, in arcseconds, is displayed on the image. Detailed information can be brought 
up in the Distance dialog box. 
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Figure 104: Displaying the Spitzer Focal Plane. A position angle of 35°  is shown. 
 

 
Figure 105: The Spitzer diffraction spikes can be toggled off and on when displaying the focal plane, 
and can be translationally repositioned to, for example, indicate the direction of diffraction spikes 
from a nearby bright object on a date you plan to observe. 
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9.7.4.8 Displaying an AOR 
Once you have selected a moving target AOR in the Archive Query Results window, you 
can display this AOR on your image for either the scheduled date or a user-specified date 
(if the AOR has not yet been scheduled).  For moving targets, the AOR display shows not 
only the spacecraft pointing and mapping motions, but also the combined effect of the 
moving target's track on those pointings.  For a rapidly moving object, you may be able 
to see the actual elongation of a mapping pattern in the direction of the object's motion. 
Leopard does not yet explicitly support visualization of a moving target AOR in the 
object's rest frame. However, this can be mimicked to a limited extent by entering a 
dummy fixed target that corresponds to the object's position at the desired observing 
time.  However, for a rapidly moving object (typically comets near perihelion or near-
Earth asteroids) this “fixed target” approximation will provide a clearer visualization of 
the map extent around the target object, but unlike the moving target visualization 
described above, it will not accurately display the background in each AOR frame.   
 
Next, select AORs on Current Image from the Overlays menu on the Leopard main menu 
bar. You will be asked if you want to plot the same visibility date for the moving target 
that you currently have plotted (Figure 106). If you don't want to do that, select "No", and 
you will be asked to supply a different date. Your requested AOR will appear on the 
image, and a set of icons associated with that display will appear on the right-hand side of 
the image window (layer controls). As for the layer controls, the  icon will toggle the 
display of the AOR, the  icon will delete the AOR display, and the  icon opens a 
table that lists all the AOR pointings. Individual pointings can then be selectively toggled 
on/off in the table. This window also gives the position angle for the AOR on the date 
specified. Furthermore, this window allows animation of the AOR - displaying the 
instrument aperture pointings in the sequence that they will be executed on-board the 
spacecraft. The "Animation" button shows the pointings, one after the other, and the 
"Animation w/ Trail" button shows the successive pointings, but leaves a trail showing 
the apertures for all previous pointings in the sequence.  
 
Multiple AORs for the same moving target can be displayed (e.g., an IRAC and a MIPS 
AOR). You may wish to ‘check’ off the previous AOR using the  icon (but not 
remove, which is done by clicking on the  icon) when doing this, to clearly see the new 
AOR overlaid.  
 
Leopard should now display the AOR on the image as shown in Figure 107. In this 
example we are overlaying a MIPS Photometry AOR of Pluto.  The different colored 
apertures correspond to the two different MIPS fields-of-view. Click on the MIPS display 
layer control pointings icon . Select Animation w/Trail.  Note that, in general, the 
instrumental mapping path that may take a zig-zag shape on the sky, as compared to what 
would be expected for a fixed target. This is because the spacecraft tracking of the 
moving target is being superimposed on the instrumental mapping motions. Note that the 
Spitzer pipeline has the capability to take these frames and recreate the map of the target 
in the target's rest frame. This will be a rectilinear map with the tracked extended target 
reassembled as a continuous image, but with the disjoint pieces of sky background that 
you may see. 
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Figure 106: When attempting to overlay AORs on an image for a moving target, this dialog appears 
indicating that the track for the target is already plotted on the image and asking whether or not to 
use the current moving target date. 

 

 
Figure 107: A MIPS AOR of Pluto is shown. Note that the observation may generally show a slight 
zig-zag shape, due to movement of the target during the observation, especially for rapidly moving 
targets. 

9.7.4.9 Add Moving Target 
Planetary satellite and other observers may wish to display not only the science target of 
an AOR, but also the relative position of a nearby moving target (e.g., the parent planet 
for a satellite).  You should enter the second target into Leopard via the List of Targets 
dialog (Figure 108), by clicking on the New Target button in that dialog and entering the 
new target’s name in the target entry dialog shown in Figure 109.  If you click the 
Resolve to NAIF ID button, Leopard will look up the NAIF ID for the target name.  If the 
name corresponds to more than one NAIF ID, a dialog such as that shown in Figure 110, 
will ask you to choose the NAIF ID you desire. 
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Figure 108: The List of Targets dialog, showing the four target positions for observations of Titan 
from the selected program. 
 

 
Figure 109: The target entry dialog.  Here you can enter a moving target name and attempt to 
resolve it by its NAIF ID.  In this case, we have entered ‘Saturn.’ 
 
See the Spot User’s Guide, section 10.3, for a more detailed discussion of moving target 
entry.  In summary, for either moving single or cluster targets, you may enter either a 
standard ephemeris specified by the NAIF ID number or a user-defined ephemeris for 
objects not yet in the NAIF database. For targets in the NAIF database, enter either the 
NAIF ID or the target name, and Leopard will return the appropriate target name or NAIF 
ID number when you click on the Resolve the Name button. A list of NAIF IDs and 
names recognizable to Leopard can be found on the Spitzer Proposal Kit web page. It is 
also possible to use the JPL DASTCOM database (http://ssd.jpl.nasa.gov/sbdb.cgi) to 
interactively search for NAIF IDs (called “SPK-IDs” on the DASTCOM database) and 
names. If the name you enter is used by more than one object in the NAIF database, 
Leopard will provide you with a list of NAIF IDs from which to select.  It is important to 
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select the correct NAIF ID for your object, as the NAIF ID is the single identifier Spitzer 
uses to provide ephemeris information. 
 

 
Figure 110: The choices of NAIF ID numbers for Saturn are shown.  It is important to select the 
correct NAIF ID for your object, as the NAIF ID is the single identifier Spitzer uses to provide 
ephemeris information. 
 
For targets not yet in the NAIF database, you may enter the orbital elements. The entry 
dialog is shown in Figure 111. Orbital elements should be specified with a reference 
frame of FK5/J2000.0.  The following heliocentric ecliptic elements to specify the orbit 
of a user-defined object are required: 
 
• Epoch:  The Julian ephemeris date (Time Dynamic Barycenter) of the osculating 

elements. 
• T: Perihelion Julian Date. 
• ω: Argument of perihelion with respect to the ecliptic (degrees). 
• Ω: Longitude of the ascending node with respect to the ecliptic (degrees). 
• Eccentricity: Eccentricity of the orbit (in the range 0 to 1). 
• Perihelion Distance: Perihelion distance for the orbit (in AU). 
• Inclination of Orbit: Inclination of the orbit with respect to the ecliptic (degrees). 
 
We do not yet have an automatic way to use these elements to generate an ephemeris 
within Leopard. Consequently, if you need a user-defined ephemeris, please contact the 
Spitzer Helpdesk (help@spitzer.caltech.edu) with your orbital elements and request 
generation of a Leopard-readable ephemeris. We will generate a temporary ephemeris for 
you and give you a dummy NAIF ID number to use within Leopard, so that you can 
generate visibility information, etc., for your target.  Note that it is required for the orbital 
elements to be entered with respect to an ecliptic and mean equinox of J2000. 
 
After entering the NAIF ID or target name into the target entry window, select the level 
of bright object avoidance you would like Leopard to include when calculating the 
visibility of your target. Then, click on the Visibility/Orientation button in the upper 
right-hand quadrant of the target entry window. If Leopard has access to the ephemeris 
corresponding to the NAIF ID of your object, it will now calculate the periods during 
which your object is visible to Spitzer. If bright object avoidance is selected, Leopard will 
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modify the visibility windows to avoid times when a bright object is near your target 
object (if appropriate).  

 

Figure 111: The entry dialog for a moving single target with a user defined ephemeris.  This is where 
you enter a target that does not yet have a NAIF ID number. 

 
Figure 112: Displayed track of Titan on an IRIS plate background. The Number of Points selected 
was 20. 
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Figure 113: The Add Moving Target overlay dialog.  With this utility, you can add the tracks of one 
or more moving targets on the track of a primary moving target.  Simply highlight one or more of 
the entries in the list and click “OK.”  In this example, we select Saturn. 

 
Figure 114: Displayed tracks of Titan and Saturn on an IRIS plate background. Each of the points 
are for the same dates for both moving objects overlaid on the image. 
 
As an example, we consider Titan and its host planet, Saturn.  First, we perform a Query 
by NAIF ID for all programs that have observed Titan. This results in a GTO program 
(pid 71), and we select one of the four targetings of Titan from the List of Targets (Figure 
108).  Next, we show an overlay of Titan’s track on an IRIS 25 µm image.  Once again, 
we are asked to enter an observation date to allow Spot to select the correct background 
image on which to display the satellite. The track of the satellite across the image on the 
date specified is visible in the Leopard image window (Figure 112). To overlay the track 
of Saturn along with the track of Titan, select the Add Moving Target utility under the 
Overlays menu.  The resulting dialog is shown in Figure 113.  Generally, you can select 
all or some of the target positions in the list (in this case, we have selected only one, 
Saturn) by highlighting the entries in the dialog and clicking “OK.”  The planet’s track is 
then overlaid on the image, along with its moon (Figure 114).  The points shown for 
Saturn are for the same dates as those of Titan.   
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If your second target does NOT cross the image in the date range specified for the first 
target, Leopard will display a window to that effect, and ask you whether you would like 
to see the position of the second target relative to the first on an All Sky image. The sky 
patch labeled "Sky Image" will show the image area that contains your first target, and 
your second target will be labeled by name, elsewhere on the All Sky Image. 

9.8 Visualizing the BCDs 
For any observed AOR in a program, you can visualize the individual BCDs produced by 
the AOR, by clicking on the BCDs tab in the Detail Information window (see section 
8.3.9).  An example is shown in Figure 115.  Clicking on the “Retrieve all BCDs” button 
results in a dialog window, shown in Figure 116.  Near the top of that dialog window is a 
pulldown menu to select an image on which to overlay the BCDs.  Select the image type 
of your choice from the menu and click “View All.”  A dialog window, similar to the 
image dialog windows discussed in section 7.6, will appear, where you can customize the 
parameters (image size, desired wavelength, etc.) for the image.  (Currently, ISSA images 
are not available.)  Click “OK,” and the image, with a representation of the individual 
BCDs overlaid on it, will appear in the Images window (Figure 117).  Note that the 
individual BCD numbers show up in the overlay. 
 
If you then click on any location within the BCD overlay, previews of the BCDs that 
cover that location will appear in the overlay (Figure 118).  The overlay layers for these 
individual BCD previews appear along the right hand side in the Image window.  These 
layers can be manipulated in the fashion described in section 9.1.4. 
 
Returning to the Detail Information window and the listing of the BCDs, if you highlight 
any of the BCDs listed here, you will see this highlighting represented in the BCD image 
overlay (see Figure 119).  Note: you can highlight more than one listed BCD.  If you then 
click on the “Display Selected BCDs” in this window, a preview of any of the highlighted 
BCDs will appear in the Images window  (Figure 120).  Using the Save Current Image as 
FITS File under the File menu (see section 7.1.3), you can save the full-resolution BCD 
FITS file to local disk.  You could download all of the BCD data for a given AOR in this 
manner.  However, it is likely faster and more convenient to use the Download Selection 
utility under the File menu, along with Subscriber, to download all of the BCD data (see 
section 10 for an example). 
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Figure 115: The Detail Information dialog.  The BCDs button is highlighted and selected in this 
dialog.  In this example we wish to overlay the BCDs that were produced by this IRS Peak-Up 
Imaging AOR.  You can do this by clicking on the “Retrieve all BCDs” button in the dialog window. 
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Figure 116: The Detail Information dialog, showing the list of individual BCDs, by index number, 
channel number, and sky position.  Near the top of the dialog window is a pulldown menu for 
selecting the image type on which we will overlay a preview of the BCDs. 
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Figure 117: The overlay of all of the BCDs, in red, that were produced by the AOR on a DSS image.  
The BCD numbers are shown in blue on the overlay. 
 

 
Figure 118: Clicking at any location within the BCD overlay, shown in Figure 117, will then retrieve 
and overlay the footprints of all of the BCDs that cover that location.  The individual BCD overlay 
layers appear to the right hand side of the Image window. 
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Figure 119: Highlighting any of the BCDs listed in the Detail Information window will highlight that 
BCD’s overlay, with blue outlines, in the Image window.  In this case, we highlighted BCD #50. 
 

 
 

Figure 120: Highlighting any of the BCDs listed in the Detail Information window and then clicking 
on the “Display Selected BCDs” button will bring up a preview of that BCD, or BCDs (you can select 
more than one), in the Image window.  In this example we have selected BCD #50.  Using the Save 
Current Plotted Image as FITS File utility under the File menu, you can save the actual BCD FITS 
files to local disk. 
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10 An example Leopard Session – Querying the Spitzer Archive 
This section walks through an example of requesting data from the Spitzer Archive. In 
this example we want to obtain the data products for the Extragalactic component of the 
First Look Survey.  The Extragalactic FLS is program ID number 26 (program name: 
fls_extragal) in the Spitzer database; for more information, see 
http://ssc.spitzer.caltech.edu/fls/. 

1. Select Query -> By Program from the menu pulldown.  The dialog shown in 
Figure 54 will appear. 

2. In the Program Section of that window, enter “26” into the field.  Next, select the 
“All” tab for all three instruments, under the Instrument Section (the Extragalactic 
FLS included only IRAC and MIPS observations). Click “OK” at the bottom of 
the window. 

3. Leopard will access the SSC servers to query the Spitzer Archive and return a 
Program List (Figure 121), listing the information (Program ID, title, PI Name, 
and number of AORs), in this case, for program 26.  Be sure this program is 
selected in the Program List window, by clicking on “Selected.”  Clicking “OK” 
will return the list of AORs in the Archive Query Results window.  

 

 
Figure 121: The Program List window, showing the information for Program ID 26. 

4. Click on the line that contains the desired AOR; in this example, the AOR with 
Label “P0026: FLS-IRAC-ver1a.” This highlights the line, selecting it as the 
active AOR in the Archive Query Results window (Figure 122). 
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Figure 122: The main Leopard window, showing that the ``P0026: FLS-IRAC-ver1a’’ AOR has been 
highlighted, after we have clicked on this AOR entry. 

5. We desire to download the data from IRAC 3.6 and 8.0 µm, so these wavelengths 
in the “Retrieve Wavelengths” column are checked. 

6. In the lower right corner of the Leopard window, we select the type of desired 
data products, selecting the BCD and Post-BCD data. In the lower left corner of 
the window will appear the estimated size of the data products selected, in 
Megabytes (Figure 123). We should check to make sure there is sufficient local 
disk space for a successful download. 

7. Click on the shortcut icon (diskette) for “Download Selections” (or select this 
option from the File Menu). A window appears with two possible download 
options (Figure 123). In this example, we select direct download and clicks “OK.” 
A window appears, allowing us to specify the directory where the data will be 
deposited (Figure 124). The local directory file structure can be browsed, to select 
the appropriate directory, and then the user should click “Open.” 

8. Leopard starts up the Subscriber tool and a Subscriber window appears (Figure 
125). The color of the Retrieve Wavelength column changes depending on the 
download status. The key to the colors is indicated to the lower left of the Leopard 
window. The column for that AOR turns completely green when the AOR has 
been queued for downloading (Figure 126). When all the data are delivered the 
Retrieve Wavelength column for the AOR will turn blue (Figure 127). The 
Subscriber window also indicates the query and download status during the 
process. If the download process will take quite some time, we can exit Leopard, 
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and the Subscriber window will stay open and continue to query and deliver the 
data to local disk. 

 

 
Figure 123: The main Leopard window, showing that the 3.6 and 8.0 µm wavelength bands, and the 
Post-BCD and BCD data, have been selected for the chosen AOR.  Also shown is the dialog with the 
two download options, which pops up when the Download Selections diskette icon is clicked at the 
bottom of the Leopard window; downloading to local disk is the preferred option. 

 
Figure 124: The Select Download directory dialog, which opens when we select direct download to 
local disk.  We can then enter the full path for the directory in which the data will be downloaded.  
Clicking “Open” will start the download. 
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Figure 125: The main Leopard window, showing that the Subscriber window has been launched.  

 

 
Figure 126: The main Leopard window, showing the status of the partial data product download for 
the data. The green color indicates that the download has been queued.  A box also opens showing 
the progress of the data download to local disk. 
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Figure 127: The main Leopard window, showing that the partial data product download is now 
complete.  This is indicated by the blue color for the download status of the 3.6 and 8.0 µm 
wavelengths. 

9. Finally, we can go to the local data directory and unzip the delivered file.  We 
should read the README file in each product’s subdirectory to ensure the data 
download completed successfully … just in case. 

 
Important items to note: If you have multiple AORs in the Archive Query Results 
window and have selected various wavelengths for retrieval for various AORs, the data 
product types you choose will be delivered (if they exist) for ALL the wavelengths for all 
of the AORs. You cannot choose to download just the BCD products for one AOR and 
the BCD and Post-BCD products for another AOR within the same download session. 
You can download them serially within one Leopard session, selecting the first AOR and 
its products, request the download, and while that is occurring, select the other AOR and 
its data products. 
 
The SSC encourages Spitzer Archive users to select the ‘Download Directly’ option for 
data delivery. Our FTP staging disk area is only so large, and delivery of your requested 
data may be delayed if the FTP area is too full to contain your request.  This is 
particularly true for MIPS BCD data! 
 


